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Line 6 fbv shortboard mkii bias fx

Description Shortboard Foot Control for Line 6 Amps and PODs Discussions ...I finally did it. The only piece left to "conquer" is storing the foot controller. I'm using a line 6 fbv shortboard mkii to control everything, and once I'm done with it, I'd like to be able to store it in the rack. Anyone have ideas on how
to accomplish this? I was thinking... ...You can get fancier and go with something from Disaster Area Designs, Morningstar, etc. I use the lowly Line 6 FBV Shortboard MKII and it is perfect for my applications. Option B: 1) Hardware Modeler: Don't want to use Bias FX & a laptop? IMO the top hardware
units are: Axe FX II XL+ or... ...to an SM Pro V-Machine VST hardware box which drives GSi "MilesTone" trumpet VST, and is further controlled by a Line 6 FBV Express MkII MIDI-controller pedalboard to control the trumpet's parameters in real time. See All Discussions Begin a Discussion This
document explains how to update your FBV Mk II (Express or Shortboard) controller using Line 6 Monkey. You will need to connect your FBV Mk II controller using a USB cable to your computer, then run the Line 6 Monkey application. If your software is out of date (or you want to reflash for trouble
shooting purposes), you will want to update using the following directions. Line 6 Monkey Installation and F.A.Q. USB Connectivity with Line 6 Devices 1) If Monkey asks you to register your gear, you can select 'remind me later'. 2) Select the "flash memory" to highlight (in blue), then select "update
selection". 3) Select "I Accept" for the software agreement and select 'continue'. 4) Decide if you want to restore the factory defaults, then select your choice (if you are reloading software for trouble shooting, select "yes"). 5) Select "yes" to continue to the update. 6) wait for the flash memory to update and
be installed, then select "OK". 7)Your unit should now be successfully updated. 驕ｸ謚槭＠縺溘き繝ｩ繝ｼ縺ｮ逕ｻ蜒上′縺ゅｊ縺ｾ縺帙ｓ縲�繧ｫ繝ｩ繝ｼ�ｼ� FBV Shortboard MkII はただのフットコントローラーではありません。完全なリモート‧コントロールが可能で、Line 6 アンプや POD® の前⾯に接
続することなく、⾜元で操作が可能です。 FBV Shortboard MkIIはボックス要らずで、接続してすぐに演奏することができます。付属の13のフット‧スイッチでプリセットをスクロールしたり再⽣したりでき、テンポ設定が必要なエフェクトをタップ‧テンポと同期したり、エフェクトやクロマチッ
ク‧チューナーを起動させたりすることが可能です。 Line 6 ギターアンプと⼀緒に使⽤すれば、フットスイッチによってQuick Loop、Pitch Glide、Smart Harmonyなど、搭載されている様々なエフェクトを起動させることができるほか、あなただけのオリジナル‧プリセットが最⼤128まで作成可能
です。丈夫で、⾜元にはしっかりとした⼤きなボリューム/ ワウ･ペダルが付いており、様々な機能を操作することができます。このペダルのおかげで、つま先でボリュームとワウの切り替えが可能（対応のLED表⽰付き）です。 ⼤型のバックライト‧ディプレイでは、読みやすいように⼤きなLCD表
⽰が取り付けられています。ここにはアクティブなプリセット名と番号、そして起動時にはクロマチック‧チューナーが表⽰されます。 Pédaliers FBV™ MkII Guide d’utilisation détaillé Utilisation des pédaliers FBV Shortboard™ MkII et FBV Express™ MkII avec le processeur Line 6 POD® X3, POD
Farm™ 2, GearBox™ et diverses applications logicielles Mode d’emploi détaillé des pédaliers FBV MkII — Table des matières Table des matières Mise en œuvre...........................................................................................1•1 Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™
MkII....... 1•1 Mise à jour et enregistrement avec Line 6 Monkey........................................................ 1•1 Installation de l’application Line 6 FBV Control........................................................... 1•3 Connexion du FBV MkII à votre POD® X3.................................................................... 1•5 Connexion du FBV MkII
à l’ordinateur.......................................................................... 1•5 Calibrage de la pédale FBV............................................................................................. 1•7 Pédale d’expression.......................................................................................................... 1•8 FBV™ MkII et POD® X3
.........................................................................2•1 Mise en œuvre rapide...................................................................................................... 2•1 Chargement des Presets utilisateur.................................................................................. 2•1 Contrôle des effets et plus
encore.................................................................................... 2•3 Configuration système du POD X3 — Réglages de pédale............................................. 2•4 Utilisation des pédales avec les sons Tone 1 et Tone 2................................................... 2•7 Gestion des Presets à doubles sons (Dual
Tone)............................................................. 2•8 L’application Line 6 FBV Control . .........................................................3•1 Quels sont les avantages ? . ............................................................................................ 3•1 Interface graphique utilisateur......................................................................................... 3•1
Fonctionnement des contacteurs au pied........................................................................ 3•5 Fonctionnement des Leds de contacteurs au pied........................................................... 3•6 Fonctionnement des pédales........................................................................................... 3•7 Ouverture et sauvegarde des
Presets FBV........................................................................ 3•7 Préférences....................................................................................................................... 3•9 Fenêtre ‘About Line 6 FBV Control Application’........................................................ 3•10 L’écran LCD du pédalier FBV Shortboard
MkII........................................................... 3•10 FBV™ MkII et POD Farm™ 2 Line 6.....................................................4•1 Qu’est-ce que le POD Farm 2 ?........................................................................................ 4•1 À propos des ports et canaux USB MIDI........................................................................ 4•1
Affectations MIDI pré-configurées de POD Farm 2........................................................ 4•3 Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII.................................... 4•3 Application autonome POD Farm 2 - Configuration des entrées MIDI........................ 4•7 Plug-In POD Farm 2 - Configuration
des entrées MIDI................................................. 4•8 Fenêtre des affectations MIDI de POD Farm 2............................................................. 4•10 Fonction d’apprentissage MIDI Learn de POD Farm 2................................................. 4•10 Mode d’emploi détaillé des pédaliers FBV MkII — Table des matières
FBV™ MkII avec Line 6 GearBox™ . ..................................................5•1 Qu’est-ce que GearBox ?.................................................................................................. 5•1 Connectez-vous............................................................................................................... 5•1 Personnalisez les contrôles de
GearBox........................................................................... 5•4 FBV™ MkII et applications logicielles.....................................................6•1 À propos des ports et canaux USB MIDI....................................................................... 6•1 Fonction d’apprentissage MIDI automatique......................................................
6•3 Affectation manuelle des contrôleurs MIDI........................................................ 6•3 Ableton Live - Tutoriel de configuration du pédalier FBV MkII.................................... 6•4 GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII.............................. 6•13 Apple Logic® — Tutoriel d’utilisation avec
le FBV MkII .......................................... 6•14 Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII .............................. 6•18 Propellerhead Reason® — Tutoriel d’utilisation avec le FBV MkII............................ 6•22 Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII....................
6•25 Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII..................................... 6•28 Références.................................................................................................7•1 Questions & Réponses..................................................................................................... 7•1
Diagnostic........................................................................................................................ 7•2 Ressources en ligne.......................................................................................................... 7•5 Line 6, FBV, FBV Shortboard, FBV Express, POD, POD Studio, TonePort, GuitarPort, POD Farm, Spider, Spider Valve,
Line 6 Monkey et GearBox sont des marques déposées de Line 6, Inc. Tous les autres noms de produits, de marques et d’artistes sont la propriété de ces personnes ou sociétés. Ces personnes ou sociétés ne sont en aucun cas liées, associées ou affiliées à Line 6. Tous droits protégés © 2010 Line 6,
Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des



possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL



est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»



en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de



Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation



de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la



Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous



pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à



d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.



Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3



FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.



Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et



le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.



Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa



présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans



FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode



d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,



comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •



Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &



Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans



un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre



SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les



indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des



données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et



sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez



voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être



déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description
détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est



utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD
Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que



vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,
Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne



permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet
pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
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Inc. Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Mise en œuvre Merci d’avoir choisi le pédalier FBV ShortboardTM MkII ou FBV ExpressTM MkII : vous pouvez maintenant commander au pied de nombreux produits Line 6, et de nombreuses applications logicielles MIDI ! Ce
document vous indique comment configurer et utiliser votre pédalier FBV™ MkII avec le POD® X3, le POD® X3 Pro, le logiciel Line 6 POD Farm™ 2, GearBox™, et d’autres applications d’enregistrement audionumériques et MIDI compatibles avec les messages de contrôle MIDI. Pour utiliser votre POD
X3, GearBox ou logiciel MIDI/audionumérique de façon optimisée et pour le fonctionnement des contacteurs et pédales du FBV, commencez par consulter les informations des modes d’emploi de ces produits. Vous trouverez d’autres informations dans le Mode d’emploi des pédaliers FBV MkII, fourni
avec le FBV. Vous pouvez également télécharger les modes d’emploi sur le site de Line 6 à la page . Pédaliers FBV MkII et amplificateurs Line 6 Spider® IV ou Spider Valve™ MkII Les pédaliers Line 6 FBV MkII ont été créés pour fonctionner avec de nombreux amplificateurs Line 6, et en particulier les
nouveaux Line 6 Spider IV et Spider Valve MkII, ce qui vous permet de gérer au pied de nombreuses fonctions comme le Quick Loop, la sélection des Presets, les paramètres d’ampli et d’effets, etc. ! L’utilisation des pédaliers FBV MkII avec les amplis Spider IV/Spider Valve MkII est abordée dans le
Mode d’emploi détaillé du Spider IV ou Spider Valve MkII, disponible en téléchargement sur le site de Line 6 . Mise à jour et enregistrement avec Line 6 Monkey Vous savez peut-être déjà comment mettre à jour et enregistrer votre pédalier FBV MkII et tous vos produits Line 6 (et vous l’avez peut être
déjà fait !), mais si cela n’est pas le cas, le moment est venu ! C’est très simple : lancez Line 6 Monkey sur un ordinateur connecté à Internet. Line 6 Monkey est le logiciel de mise à jour intelligent installé par Line 6 avec ses produits. Si vous ne l’avez pas, téléchargez- le gratuitement sur le site Line 6 à
la page www.line6.com/monkey/. Une fois que vous avez installé Line 6 Monkey, connectez votre pédalier FBV MkII au port USB de votre ordinateur (et déconnectez tous vos autres équipements USB Line 6, pour que Line 6 Monkey contrôle votre pédalier FBV). Quittez l’application FBV Control et
toutes les autres applications MIDI/audionumériques ouvertes. Avec la connexion Internet de votre ordinateur active, suivez les étapes suivantes pour lancer Line 6 Monkey... • Sur Mac®, allez dans Applications > Line 6 > Line 6 Monkey • Sur Windows®, allez dans le menu Démarrer > Programmes >
Line 6 > Tools > Line 6 Monkey Compte enregistré (Login) Vous devez utiliser un compte enregistré pour que Line 6 Monkey communique avec le serveur de Line 6 et vous fournisse les mises à jour adaptées à vos produits. C’est génial, et c’est gratuit ! 1•1 Mode d’emploi détaillé des pédaliers FBV MkII
— Mise en œuvre • Si vous avez déjà un compte Line 6, saisissez votre nom d’utilisateur (User Name) et mot de passe (Password) en haut de la fenêtre de Monkey. • Si vous n’avez pas encore de compte, cliquez sur le bouton de nouveau utilisateur (New User) et suivez les étapes à l’écran. Enregistrez
votre pédalier FBV L’enregistrement de votre produit Line 6 est nécessaire pour bénéficier des mises à jour et de certaines autorisations produit. Cette procédure vous permet également de bénéficier de la garantie et nous permet de vous contacter lorsque nous créons de nouvelles versions logicielles
ou pour toute autre amélioration du produit ! Si vous ne l’avez pas encore fait, l’écran vous demandera d’enregistrer le pédalier FBV MkII connecté. Cliquez simplement sur Register et remplissez les champs de la page Web. Elle affiche tous vos équipements Line 6 enregistrés. Téléchargez les mises à
jour Lorsque Line 6 Monkey se lance, il détecte automatiquement votre pédalier FBV MkII connecté. Dans la page des mises à jour Sup.dates de Line 6 Monkey, si vous voyez le symbole , sélectionnez l’élément dans la liste, cliquez sur le bouton Sup.date Selection, et laissez le petit singe vous aider à
l’installer. Les éléments de la fenêtre Sup.dates avec le signe , ne nécessitent aucune action. Si vous prévoyez de connecter votre pédalier FBV à votre ordinateur, laissez Monkey télécharger l’application Line 6 FBV Control (nous abordons cette application dans les chapitres suivants). Notez que la
colonne de droite vous indique les numéros de version de tous les éléments installés, ainsi que les mises à jour disponibles. Cliquez sur n’importe quel élément de la liste Sup.dates et lisez sa description dans la zone Help et Info inférieure. À gauche, vous pouvez voir le pédalier FBV connecté, son
numéro de série unique ESN (Electronic Serial Number), que vous devez utiliser en cas de réparation ou pour l’enregistrement. L’application Monkey vous offre la méthode la plus simple pour conserver vos équipements et applications Line 6 à jour ! 1•2 Mode d’emploi détaillé des pédaliers FBV MkII —
Mise en œuvre Mise à jour de la mémoire Flash Si Monkey vous indique qu’il y a une nouvelle mémoire Flash disponible, vous devez l’installer pour bénéficier des meilleures performances et de la meilleure compatibilité avec votre FBV. Suivez les étapes indiquées par Monkey, et notamment les points
suivants : • Quittez toute application MIDI/audionumérique Line 6 ou autre qui utilise votre pédalier. • Veillez à ne pas appuyer sur les contacteurs, à ne pas déplacer la pédale, et à ne pas modifier les câblages sur le pédalier FBV avant que la mise à jour ne soit terminée. • Lorsque Line 6 Monkey vous
indique que la mise à jour est terminée, quittez Line 6 Monkey et lancez-le à nouveau pour voir si d’autres mises à jour sont disponibles. Installation de l’application Line 6 FBV Control Si vous prévoyez d’utiliser votre pédalier FBV MkII pour gérer une application sur votre ordinateur Mac® ou Windows®,
installez la dernière version du logiciel Line 6 FBV. Ce logiciel gratuit vous permet de créer, charger, éditer et sauvegarder vos Presets FBV - des configurations personnalisées complètes de contrôleurs MIDI - le tout dans une même application simple d’utilisation ! Remarque : Les chapitres qui suivent
abordent l’installation du logiciel FBV Control. Consultez le chapitre «L’application Line 6 FBV Control» pour obtenir de plus amples détails ! 1•3 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Systèmes requis Il est conseillé de lire le document séparé, Notes sur le logiciel Line 6 FBV
Control, pour obtenir la description détaillée des éléments requis, ainsi que les informations les plus récentes sur la compatibilité avec d’autres périphériques et logiciels. Ce document peut être lu par les liens suivants : Communauté d’aide en ligne de Line 6, ou par la page de L’aide en ligne du pédalier
FBV MkII.. Le logiciel Line 6 FBV Control est compatible avec les systèmes d’exploitation suivants : • Windows® XP Home ou Professional, Service Pack 2 (ou plus récent), en version 32 et 64 bits • Windows Vista® Home, Business ou Ultimate Edition, en version 32 et 64 bits • Windows® 7 Home ou
Professional, en version 32 et 64 bits • Mac OS® X 10.4 (Tiger®), 10.5 (Leopard®), 10.6 (Snow Leopard®) Remarque pour les utilisateurs de Windows® 7 et Vista® : Il est déconseillé de quitter Windows® par le mode de veille pendant que Line 6 FBV Control tourne, ou lorsque votre FBV est connecté à
votre port USB. Du fait du fonctionnement du pilote USB de Windows®, certains périphériques USB (comme FBV) ne sont pas initialisés correctement lorsqu’ils quittent le mode de veille. Si l’utilitaire Line 6 Monkey est déjà installé sur votre ordinateur... Connectez le périphérique Line 6 FBV MkII au port
USB de votre ordinateur Mac® ou Windows® et lancez Line 6 Monkey. Il scanne votre ordinateur pour trouver le dernier installeur de FBV Control (ainsi que les autres mises à jour recommandées). Sélectionnez l’application Line 6 FBV Control dans la page Sup.dates de Line 6 Monkey et suivez les
indications de téléchargement et de lancement de l’installeur. Suivez les indications de l’installeur du logiciel FBV Control. Si l’utilitaire Line 6 Monkey n’est pas installé sur votre ordinateur... Vous pouvez télécharger gratuitement l’installeur le plus récent du logiciel Line 6 FBV Control sur le site
www.line6.com/software/. Sélectionnez votre pédalier FBV MkII dans le sélecteur de Produits, “Line 6 FBV Control” dans le sélecteur Software, puis votre système d’exploitation Mac® ou Windows® dans le champ de sélection OS. Une fois téléchargé, lancez l’installeur en suivant les instructions.
L’installeur de FBV Control installe également la dernière version de Line 6 Monkey — vous n’avez pas besoin de les télécharger séparément. Notez que vous n’avez pas besoin d’un pilote USB spécial pour votre pédalier FBV MkII — reliez simplement le câble USB à votre ordinateur Mac® ou
Windows® pour que celui-ci le détecte comme nouveau périphérique USB. Compatibilité logicielle Line 6 POD Farm 2 en version autonome et en version Plug-In offre des fonctions de gestion par MIDI très élaborées, et votre pédalier FBV MkII est le contrôleur USB MIDI parfait (voir «FBV™ MkII et POD
Farm™ 2 Line 6» en page 4•1)! La version antérieure POD Farm™ 1.1 ne permet pas le contrôle MIDI externe. Si vous souhaitez utiliser votre pédalier FBV MkII pour contrôler le logiciel GearBox™ Line 6, installez la version 3.7 de GearBox (ou plus récente) pour obtenir les meilleurs résultats (voir
«FBV™ MkII avec Line 6 GearBox™» en page 5•1). Pour obtenir la dernière version de GearBox, connectez le processeur USB audio Line 6 que vous souhaitez utiliser avec GearBox (processeur TonePort™, POD Studio™ ou GuitarPort™), et lancez Line 6 Monkey, ou allez directement à la page des
téléchargements Téléchargements Line 6 et sélectionnez “GearBox” pour accéder à l’installeur le plus récent. 1•4 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Pour désinstaller le logiciel Line 6 FBV Si vous devez désinstaller l’application, procédez comme suit : • Mac® - Ouvrez le
Finder et recherchez le dossier Applications > Line 6. Faites glisser l’application Line 6 FBV Control dans la corbeille pour la supprimer. • Windows® - Allez dans Démarrer > Programmes > Line 6 > Tools et sélectionnez l’utilitaire Line 6 Uninstaller. Cette application très pratique vous permet de supprimer
quelques applications et pilotes Line 6. Vous pouvez supprimer l’application Line 6 FBV Control de cette façon. Connexion du FBV MkII à votre POD® X3 La connexion du pédalier FBV Shortboard MkII ou FBV Express MkII à un POD X3 ou à un POD X3 Pro est réalisée par un simple câble. •
Commencez par placer votre POD X3 hors tension. Le FBV est fourni avec un câble avec connecteurs “RJ-45”. Notez que c’est un câble réseau “Catégorie 5”. Si vous perdez le cordon, ou si votre batteur fait tomber une cymbale dessus, vous trouverez un câble de remplacement auprès de votre
revendeur informatique. • Connectez l’une des extrémités du câble à l’embase TO AMP à l’arrière du FBV, et l’autre à l’embase FBV PEDAL du POD X3. • Placez le POD X3 sous tension. L’alimentation est fournie au FBV MkII par le câble. L’écran du FBV devrait indiquer un nom de Preset et/ou certains
témoins doivent être allumés. Remarque : Veillez à ne pas connecter un câble USB au FBV MkII lorsque vous utilisez la liaison RJ- 45 décrite ci-dessus, car ceci place le FBV en “mode USB” pour communiquer avec l’ordinateur. Vous pouvez cependant connecter le POD X3 à votre ordinateur avec le
câble USB (entre le POD X3 et le port USB 2.0 de votre ordinateur) si vous souhaitez utiliser le POD X3 comme interface USB audio, ou avec GearBox, pour contrôler simultanément le POD X3 avec votre FBV ! Connexion du FBV MkII à l’ordinateur Pour utiliser le pédalier FBV Shortboard MkII ou FBV
Express MkII pour contrôler votre logiciel, connectez un câble USB standard entre le port USB du FBV et n’importe quel port USB 1.1 ou 2.0 de votre ordinateur Mac® ou Windows®. Le pédalier FBV MkII est alimenté par cette liaison USB. L’écran LCD du FBV doit s’allumer à la mise sous tension. La
première fois que vous connectez le FBV Shortboard/Express MkII au port USB de votre ordinateur, le système d’exploitation Mac OS® X ou Windows® doit installer un pilote pour que le FBV fonctionne avec les périphériques et les applications de l’ordinateur. Sur un ordinateur Mac® ou Windows® 7 ou
Vista®, le processus est automatique, et vous pouvez passer à la section suivante pour utiliser votre FBV. 1•5 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Avec Windows® XP, vous devez suivre une procédure un peu plus longue pour installez le pilote du périphérique. Lorsque
vous connectez le câble USB, Windows® XP devrait détecter le nouveau périphérique en bas de l’écran : Ensuite, l’assistant d’installation des périphériques doit se lancer. Sélectionnez “No, not this time” (Non, pas cette fois), puis cliquez sur Suivant (Next). Dans la fenêtre suivante, sélectionnez “Installer
automatiquement” et cliquez sur Suivant. Notez que Windows® XP détecte le FBV MkII comme un “Périphérique audio USB”. C’est normal de la part du pilote USB universel de Windows®. 1•6 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Vous devriez ensuite voir la fenêtre suivante
vous indiquer que l’installation est terminée - cliquez sur Terminer. Votre FBV est prêt ! Calibrage de la pédale FBV Remarque : Les étapes de calibration suivantes ne sont pas nécessaires si votre pédalier FBV MkII possède la mémoire Flash 1.00. Ceci dit, toute mise à jour de la mémoire Flash après la
version 1.00 necessite le calibrage de la pédale du FBV pour obtenir les meilleurs résultats possibles. Vérifiez la version de la mémoire Flash actuelle de vore pédalier FBV MkII, ou pour télécharger et installer une mémoire Flash plus récente, utilisez l’application Line 6 Monkey, en suivant les instructions
de mise à jour de la page 1•2. Pour obtenir les meilleurs résultats possibles avec votre pédalier FBV Shortboard ou Express MkII, il est conseillé de “calibrer” la pédale avant de l’utiliser avec votre ordinateur, votre ampli Line 6 ou votre POD. Étapes de calibrage du pédalier FBV Shortboard MkII •
Déconnectez le pédalier FBV de tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche
“CALIBRATE PEDAL” jusqu’à ce que vous relâchiez le contacteur D. “1 PEDAL TOE” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2 PEDAL MIN”, ce qui devrait être instantané. • Placez
la pédale en position minimale (sur le talon). Une fois la pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3 PEDAL MAX”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette
position et appuyez et relâchez le contacteur D. L’écran LCD affiche “CHECK VALUE 127”. • Déplacez la pédale et vérifiez que l’écran LCD affiche “CHECK VALUE 0” en position minimum et “CHECK VALUE 127” en position maximum. • Si les valeurs affichées ne sont pas “0” ou “127”, recommencez le
calibrage. Si les valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! 1•7 Mode d’emploi détaillé des pédaliers FBV MkII — Mise en œuvre Calibrage de la pédale FBV Express MkII • Déconnectez le pédalier FBV de
tout port USB ou de tout équipement Line 6 (il est par conséquent hors tension). • Maintenez le contacteur au pied “D” enfoncé pendant la mise sous tension du FBV (en le connectant au port USB de votre ordinateur, ou à votre processeur Line 6). L’écran LCD affiche “CALIBRATE PEDAL” jusqu’à ce
que vous relâchiez le contacteur D. “1” s’affiche alors. • Appuyez sur la pédale pour la placer complètement en avant et appuyez sur le contacteur de la pointe du pied jusqu’à ce que l’écran LCD affiche “2”, ce qui devrait être instantané. • Placez la pédale en position minimale (sur le talon). Une fois la
pédale en position minimale, appuyez et relâchez le contacteur D. L’écran LCD affiche “3”. • Placez la pédale en position maximale (sur la pointe du pied), sans appuyer sur le contacteur de pointe. Maintenez la pédale dans cette position et appuyez et relâchez le contacteur D. Les 7 Leds au-dessus de
l’écran de l’accordeur s’allument. • Déplacez la pédale et vérifiez que les Leds de l’accordeur soient toutes allumées en position maximale (pointe) et toutes éteintes en position minimale (sur le talon). • Si les 7 Leds ne s’allument pas ou ne s’éteignent pas comme décrit, recommencez le calibrage. Si les
valeurs sont correctes, la calibration est réussie. Placez le FBV hors tension, puis à nouveau sous tension. Il est calibré et prêt à l’utilisation ! Pédale d’expression Si vous possédez un pédalier FBV Shortboard MkII, vous pouvez ajouter une deuxième pédale pour encore augmenter les possibilités de
contrôle ! La pédale d’expression Line 6 EX-1 a été conçue pour le FBV Shortboard MkII, et se connecte à l’embase la pédale d’expression à l’arrière du boîtier. Vous pouvez acheter la pédale EX-1 sur le site de la Boutique en ligne de Line 6, ou auprès des revendeurs Line 6. Remarque : La pédale
d’expression externe ne nécessite aucune calibration. Une fois que vous avez terminé les étapes de calibrage, vous pouvez passer aux chapitres suivants sur l’utilisation détaillée des pédaliers Line 6 FBV™ MkII ! 1•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV™ MkII et POD® X3
Dans ce chapitre, nous allons aborder l’utilisation du FBV Shortboard™ MkII ou FBV Express™ MkII avec un “haricot” POD® X3 ou un POD® X3 Pro. Les instructions sont les mêmes avec le POD X3 et le X3 Pro, sauf mention contraire. Votre pédalier FBV MkII devrait déjà être connecté à votre POD
X3. Sinon, consultez la section «Mise en œuvre» pour les explications. Allez, on y va... Mise en œuvre rapide OK, nous savons que vous ne pouvez plus attendre ! Comme vous avez pu vous en rendre compte, le pédalier FBV MkII est quasiment directement prêt à fonctionner avec le POD X3, mais voici
quelques astuces... • Sélecteurs de canaux A, B, C, D : Sélectionnent l’un des quatre “canaux” de la banque courante du dossier User de votre POD X3. • FBV Shortboard MkII : Appuyez sur les contacteurs au pied “Bank” (repérés par les flèches haut/bas) pour faire défiler les banques utilisateur, puis
appuyez sur les contacteurs au pied A - D pour charger le Preset souhaité à l’intérieur de la banque utilisateur sélectionnée. • FBV Express MkII : Tournez le bouton “Press to Save” du POD pour faire défiler les banques utilisateur : les contacteurs de canaux A - D vous permettent de sélectionner un
Preset à l’intérieur de la banque utilisateur actuelle. • Pédale : Gère en général la Wah ou le Volume du Preset courant - appuyez sur la pédale pour activer le contacteur de la pointe du pied et sélectionner la Wah ou le Volume. • Tap : Tapez le tempo pour synchroniser votre délai ou votre effet de
modulation sur le morceau. • Contacteurs au pied d’effets (Shortboard uniquement) : Appuyez sur ces contacteurs au pied pour activer/désactiver l’effet indiqué dans le Preset actuel. • Contacteurs au pied des fonctions 1 et 2 (Shortboard uniquement) : Par défaut, ils permettent d’activer/désactiver le
compresseur et l’ampli, à l’intérieur du Preset courant. On continue ? De nombreuses autres astuces vous attendent ! Chargement des Presets utilisateur Il y a de fortes chances pour ce soit la raison principale de l’utilisation de votre pédalier FBV MkII... Vous pouvez charger instantanément vos Presets
au pied ! C’est très simple : le FBV vous donne l’accès direct aux Presets du répertoire User du POD X3. Dès que vous appuyez sur un contacteur du FBV pour charger un Preset, vous passez directement au répertoire User, quel que soit le répertoire d’origine du Preset précédent. FBV Shortboard MkII
BANQUE SUP./INF. : Appuyez sur le contacteur Bank Sup. ou Inf. pour préparer la banque utilisateur et le canal suivants. Par exemple, si le Preset 1B est chargé, appuyez sur le contacteur au pied Banque Sup. Le nom du son Tone sélectionné dans le Preset 2B clignote à l’écran, vous indiquant sa
présence, mais sans pour autant quitter le Preset 1B. CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B, C, ou D pour charger le Preset correspondant de la banque utilisateur. Après avoir appuyé sur le contacteur de banque Sup. ou Inf., l’écran clignote, en attendant que vous
sélectionniez un canal. Comme dans l’exemple précédent, appuyez sur A pour charger le Preset 2A, ou appuyez sur B pour charger le Preset 2B, etc. 2•1 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 FBV Express MkII CHARGEMENT DE CANAL : Appuyez sur le contacteur au pied A, B,
C, ou D pour charger le Preset correspondant de la banque utilisateur. Pour sélectionner l’une des banques 1 - 32 à l’intérieur du répertoire User du POD X3, tournez le bouton “Press to Save” du POD. Page d’accueil du POD X3 La page d’accueil du POD X3 vous permet de voir les détails du Preset
courant. Lorsque le POD X3 est réglé sur le répertoire User, vous pouvez appuyer sur la touche HOME pour afficher le “trajet du signal” ou le “grand écran utilisateur”. Ce grand écran affiche le nom des sons et facilite la lecture à distance du n° de banque de Preset/canal, ce qui est très utile lorsque vous
utilisez le FBV/POD X3 sur scène - ou lorsque vous essayez de frimer avec vos lunettes de soleil bon marché : Page d’accueil du POD X3 - Trajet du signal et affichage de grande taille Répertoire des Presets utilisateur (User ) Comme vous l’avez probablement découvert, le POD X3 comprend plus de
350 Presets qui sont organisés en “répertoires ”. Vous pouvez naviguer dans ces répertoires depuis la page d’accueil du POD X3 en tournant le bouton correspondant : Tournez pour sélectionner un répertoire Le répertoire utilisateur User regroupe 128 Presets utilisateur que vous pouvez utiliser pour
sauvegarder vos propres Presets. Si vous appuyez sur l’un des contacteurs de canal du FBV (A, B, C, D), le POD X3 passe directement au répertoire utilisateur, et au Preset de la banque courante. Pour configurer votre équipement FBV/POD X3, vous créez vos propres Presets de sons exactement
comme vous le souhaitez, puis vous les sauvegardez dans les 128 mémoires du répertoire utilisateur User. Ces Presets utilisateur sont alors accessibles avec le FBV. Vous pouvez voir que nous avons créé quelques Presets dans le répertoire User. Vous pouvez les modifier. Vous pouvez également
sélectionner manuellement un autre répertoire sur le POD X3 et utiliser ses boutons pour faire défiler les autres Presets*. Vous pouvez aussi les modifier, et lorsque vous appuyez sur la touche SAVE, vous pouvez sélectionner l’un des 128 Presets du répertoire utilisateur pour y sauvegarder votre Preset
modifié qui devient dès lors sélectionnable depuis le pédalier FBV. 2•2 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 *Si vous utilisez un FBV Shortboard MkII, notez que l’écran LCD idique toujours le titre du Preset courant du POD X3, même si le Preset est à l’intérieur d’un répertoire autre
que le répertoire utilisateur. Les contacteurs et pédales du FBV contrôlent le son courant, mais les contacteurs de banque et A, B, C, D font toujours revenir le POD X3 au répertoire utilisateur et l’un des 128 Presets utilisateur. Contrôle des effets et plus encore Le FBV vous permet d’accéder à d’autres
fonctions du POD X3, comme l’accordage, la modification en temps réel de certains effets et plus encore. Remarque : Les Presets du POD X3 peuvent être composés de deux sons Tones, avec leurs propres effets et leurs propres paramètres d’effets. Comme lorsque vous accédez aux blocs d’effets et
aux paramètres directement sur le POD X3, l’utilisation des contacteurs suivants contrôle uniquement les effets du son sélectionné. Pour sélectionner le son Tone 1 ou Tone 2, utilisez le bouton TONE 2 du POD X3, ou les utilisateurs du Shortboard peuvent configurer le contacteur FUNC 1 en sélecteur
de son Tone. Consultez «Gestion des Presets à doubles sons (Dual Tone)» en page 2•8. FBV Shortboard MkII FUNC 1 : Par défaut, ce contacteur active/désactive l’effet COMP. Mais vous pouvez aussi le configurer pour activer/désactiver le paramètre Amp+Cab, sélectionner le son Tone 1/2, ou
activer/désactiver la boucle d’effets FX Loop (X3 Pro uniquement). ASTUCE : L’écran système du POD X3 comprent un réglage “LP SW” (Loop Switch) pour les sons Tone 1 et Tone 2 vous permettant de sélectionner quelle action est déclenchée par le contacteur FUNC 1 du FBV Shortboard. Ce
paramètre est réglable dans chaque Preset utilisateur. Consultez «Configuration système du POD X3 — Réglages de pédale» en page 2•4. FUNC 2 : Active/désactive le bloc AMP+CAB. STOMP : Active/désactive le bloc STOMP. MOD : Active/désactive le bloc MOD. DELAY : Active/désactive le bloc
DLY. REVERB : Active/désactive le bloc VERB. TAP : Vous permet de taper un tempo pour synchroniser les effets de délai et de modulation. La Led au-dessus du contacteur clignote au rythme du tempo actuel. ACCORDEUR : Maintenez enfoncé le contacteur au pied TAP pendant 2 secondes pour
lancer l’accordeur. Le FBV affiche alors l’accordeur. Appuyez sur le contacteur au pied et relâchez pour quitter. ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper (MUTE) le signal ou non (tout le
monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée (ainsi que la pédale d’expression connectée) peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah,
Volume, Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales en fonction de chaque son Tone. Témoins de pédale VOL et WAH : Les deux témoins lumineux à gauche de la pédale intégrée indiquent le mode actuel.
Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre TWEAK affecté. Vous pouvbez sélectionner le paramètre TWEAK dans les menus de nombreux effets. Consultez la section suivante Configuration système du POD X3. 2•3 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3
FBV Express MkII TAP TEMPO : Vous pouvez taper un tempo pour synchroniser les effets de délai et de modulation sur la musique en tapant sur le contacteur au pied A, B, C ou D allumé. Une Led à l’intérieur de la zone de l’accordeur clignote et indique le tempo. ACCORDEUR : Maintenez le
contacteur au pied A, B, C ou D allumé pendant 2 secondes pour activer l’accordeur. L’affichage devient actif. Pour quitter l’accordeur, appuyez et relâchez simplement n’importe quel contacteur au pied (vous revenez au même Preset). Vous pouvez aussi appuyer au maximum sur la pédale et
enclencher le contacteur de la pointe du pied pour quitter l’accordeur (vous pouvez ainsi sélectionner la fonction WAH ou VOL pour la pédale). ASTUCE : Vous pouvez également régler le fonctionnement “AUDIO” de l’accordeur du POD X3 directement dans la page d’accordeur du POD X3 pour couper
(MUTE) le signal ou non (tout le monde aime bien que la guitare soit accordée, mais personne n’a envie de vous entendre vous accorder). Pédale : La pédale intégrée peut être assignée au contrôle des sons Tone 1, Tone 2, des deux sons Tones, et assignée à différentes fonctions (Wah, Volume,
Tweak). Consultez la section suivante Configuration système du POD X3 pour savoir comment modifier le fonctionnement de ces pédales. Témoins de pédale VOL et WAH : Ces témoins à gauche de la pédale indiquent le mode. Lorsque les deux témoins sont allumés, la pédale contrôle le paramètre
TWEAK. Vous pouvez sélectionner le paramètre TWEAK dans de nombreux menus. Voir Configuration système du POD X3. Configuration système du POD X3 — Réglages de pédale Il y a plusieurs options que vous pouvez modifier sur la première page de la fenêtre SYSTEM du POD X3 et relatives
aux pédaliers FBV Shortboard et Express. Sur le POD X3, maintenez le bouton OUTPUTS/Hold for System enfoncé pour accéder à l’écran SYSTEM. Page 1 de l’écran System du POD Les trois réglages PEDAL de la rangée supérieure vous permettent de configurer le fonctionnnement de la pédale
Wah/Volume/Tweak du FBV MkII avec le Preset courant. Notez que les pédales offrent plusieurs “modes” de fonctionnement configurables en Wah, Volume ou Tweak. La pédale peut être configurée séparément pour le son Tone 1 et pour le son Tone 2. • FBV Shortboard MkII - Ce pédalier comporte une
pédale intégrée, la pédale “1”. Lorsqu’aucune pédale d’expression n’est connectée au FBV Shortboard, les options de pédale “2” ne sont pas actives (indiqué par les réglages entre parenthèses de la capture d’écran System ci-avant). • Lorsqu’une pédale d’expression est connectée au Shortboard, elle
devient la pédale “2”, et les options de la pédale 2 deviennent actives (sans parenthèses dans le menu System) : 2•4 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Menu System du POD X3 - Pédalier Shortboard avec pédale d’expression • FBV Express MkII - Comprend une pédale
intégrée, la pédale “1”. Vous n’avez pas la possibilité de connecter une 2èmes pédale, par conséquent, les options de la pédale 2 sont affichées entre parenthèses dans le menu System pour indiquer qu’elles ne sont pas actives. Ces paramètres système PEDAL, TWK et LP SW sont spécifiques au
Preset courant - ce qui signifie que vous configurez chacun de ces réglages et que vous les SAUVEGARDEZ avec les autres réglages de pédale(s) FBV individuellement pour chaque Preset. Remarque : Les Presets de votre POD X3 peuvent posséder un ou deux sons (Tone 1 et Tone2). Les réglages
système vous permettent toujours de visualiser et d’éditer les paramètres du son “Tone 2”, même si le Preset sur lequel vous travaillez ne possède pas de son Tone 2 actif. PEDAL CNTRL - Utilisez ce réglage PEDAL système de gauche pour que la pédale affecte le son TONE 1, TONE 2 ou les deux
(BOTH). Le mode par défaut est le mode BOTH pour tous les Presets. Vous pouvez librement définir le fonctionnemenet de la pédale pour chaque Tone d’un Preset : TONE 1 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 1 et suit les réglages de “mode” PEDAL du son
Tone 1, quels que soient les réglages de pédale du son Tone 2. TONE 2 ONLY - La pédale 1 (et la pédale 2, si connectée) affecte uniquement le Tone 2 et suit les réglages de “mode” PEDAL du son Tone 2, quels que soient les réglages de pédale du son Tone 1. BOTH TONES - La pédale 1 (et la
pédale 2, si connectée) affecte le son Tone 1 et suit les réglages de “mode” PEDAL du son Tone 1 et affecte en même temps le son Tone 2 en suivant les réglages de mode PEDAL du son Tone 2. Remarque : Pour en savoir plus sur les options de pédaliers FBV avec les Presets à deux Tones,
consultez la section suivante “Utilisation des pédales avec les sons Tone 1 et Tone 2”. TONE1 PEDAL - Utilisez ce réglage TONE1 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) avec le Tone 1. Ces réglages sont uniquement pour le son Tone 1, et
la valeur que vous avez affectée au réglage PEDAL CNTRL (voir précédemment) determine si le Tone 1 est contrôlé ou non par votre (ou vos) pédale(s). Notez que les options de pédale diffèrentr si vous vous utilisez un pédalier FBV Shortboard avec une pédale d’expression connectée... Options
PEDAL TONE1 pour le FBV Express et le Shortboard sans pédale d’expression : • 1-W/V 2-VOL - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas
actives. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak actuellement assigné au Tone 1 (voir section TONE1 TWK suivante). Les options de la pédale 2 ne sont pas actives. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe
du pied sélectionnant l’un de ces deux effets pour le Tone 1. Les options de la pédale 2 ne sont pas actives. 2•5 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Options PEDAL TONE1 du pédalier FBV Shortboard avec une pédale d’expression : • 1-W/OFF 2-VOL - La pédale 1 contrôle la
Wah, avec le contacteur de la pointe du pied sélectionnant le carcatère On/Off de la Wah. La pédale 1 n’a aucune fonction lorsque la Wah est désactivée. La pédale 2 contrôle en permanence le volume. • 1-TWK 2-VOL - La pédale 1 contrôle le paramètre Tweak assigné au Tone 1 (voir section TONE1
TWK suivante). Le contacteur de la pointe du pied n’a aucune fonction. La pédale 2 contrôle le volume du son Tone 2. • 1-W/V 2-TWK - La pédale 1 contrôle le paramètre de position de Wah ou de Volume, avec le contacteur de la pointe du pied sélectionnant l’un ou l’autre pour le Tone 1. La pédale 2
contrôle le paramètre Tweak assigné au Tone 2 (voir TONE2 TWK ci-dessous). TONE2 PEDAL - Utilisez ces réglages de TONE2 pour configurer les deux “modes” de fonctionnement des pédales 1 et 2 (si la pédale 2 est connectée) pour le Tone 2. Les options PEDAL TONE2 sont les mêmes que celles
décrites plus haut dans la section TONE1 PEDAL, mais dans ce cas, les réglages affectent uniquement le son Tone 2, pour permettre une utilisation indépendente des pédales par Tone. Les valeurs PEDAL CNTRL (voir description précédente) déterminent si le Tone 2 est contrôlé par vos pédales.
Utilisez les options TONE2 TWK ci-dessous pour configurer la fonction “Tweak” du TONE2 . TONE1 TWK - (Tweak) Si vous avez assigné l’une des options TONE1 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. La liste des
paramètres est trop longue : tournez le bouton. Vous comprendrez ! TONE2 TWK - (Tweak) Si vous avez assigné l’une des options TONE2 PEDAL au réglage TWK, ceci vous permet de sélectionner le paramètre contrôlé par la pédale assigée au paramètre TWK. TONE1 LP SW (Shortboard
uniquement) - Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionner ce que le contacteur au pied FUNC 1 du FBV Shortboard contrôle pour le Tone 1 (notez que les possibilités ont été étendues au-delà de la boucle On/Off “Loop Switch” — ne vous laissez pas
abuser par la simplicité du nom !). Les options pour Tone 1 sont : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp+Cab. • LOOP - (POD X3 Pro uniquement) Active/désactive la boucle d’effet FX Loop. • DUAL - Permet la même sélection Tone 1/Tone 2 que le bouton
TONE 2 (Hold For Dual) du POD X3, avec la fonction Hold For Dual pour activer/désactiver les sons Dual Tone au pied. Remarque : Vous remarquerez que le fait de passer à l’option DUAL modifie également automatiquement l’option TONE2 LP SW sur DUAL. TONE2 LP SW (Shortboard uniquement) -
Ce réglage de commutateur de boucle LP SW (“Loop Switch”) vous permet de sélectionnner ce que le contacteur au pied FUNC 2 du FBV Shortboard contrôle pour le son Tone 1. Options pour le son Tone 1 : • COMP - Active/désactive le bloc Compressor. • AMP - Active/désactive le bloc Amp. • LOOP -
(POD X3 Pro uniquement) Active/désactive la boucle d’effets FX Loop. • DUAL - Applique aux deux sons Tone 1 et Tone 2 le même fonctionnement que le contacteur TONE 2 (Hold For Dual), ce qui comprend la fonction Hold For Dual pour activer/désactiver le double son Dual Tone avec le contacteur
au pied. 2•6 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 ASTUCE : Souvenez-vous, que ces réglages SYSTEM sont spécifiques à chaque Preset utilisateur, alors pensez à SAUVEGARDER les réglages avec chaque Preset que vous modifiez ! Utilisation des pédales avec les sons Tone 1
et Tone 2 Prenons le temps de jeter un œil aux options et fonctionnements possibles de la pédale du FBV (et de la pédale d’expression) avec les Presets Dual Tone. Comme nous l’avons vu, les options des modes PEDAL TONE1 et TONE2 (Wah/Volume/Tweak) offrent différentes affectations de pédale
par Tone (ainsi que par pédale, si vous utilisez un pédalier FBV Shortboard avec une pédale d’expression externe). Par conséquent, lorsque vous configurez ces options de pédale dans un Preset, réflechissez à ce que what vous souhaitez contrôler dans le trajet de chaque Tone. Voici certaines des
possibilités : • Contrôler une Wah dans le Tone 1 ou le Tone 2 uniquement • Contrôler une Wah dans les deux Tones en même temps avec la même pédale • Contrôler une Wah dans le Tone 1 avec la pédale 1 et une Wah séparément dans le Tone 2 avec la pédale 2 • Contrôler un paramètre Tweak
uniquement dans le Tone 1 ou dans le Tone 2 • Contrôler un paramètre Tweak commun aux deux Tones avec une seule pédale • Contrôler deux paramètres Tweak différents en même temps dans chaque Tone avec une seule pédale • Contrôler un paramètre Tweak du Tone 1 avec la pédale 1 et un
paramètre Tweak différent du Tone 2 avec la pédale 2 Lorsque vous chargez un Preset Dual Tone avec le paramètre PEDAL CNTRL réglé sur BOTH TONES avec les mêmes réglages de mode pour PEDAL TONE1 et PEDAL TONE2, la pédale du FBV et son contacteur de pointe du pied contrôlent le
même effet pour les deux Tones en même temps (pas mal, non ?). Si vous sélectionnez “1-W/V” pour PEDAL TONE1 et PEDAL TONE2, alors la pédale intégrée au FBV contrôle simultanément la Wah ou le Volume des deux Tones. Le fait de cliquer sur le contacteur de la pointe du pied sélectionne
également la Wah ou le Volume pour les deux Tones*. Il en va de même si vous réglez les modes de la pédale 2 sur “2-TWK” pour les sons Tone 1 et 2, puis les paramètres Tweak assignés sont contrôlés simultanément pour les deux sons Tones par la pédale 2. Il est également possible de gérer
séparément l’affectation du paramètre TWK, de sorte que le paramètre contrôlé par la pédale 2 soit indépendant pour chaque Tone. Par exemple, le Tone 1 peut avoir son réglage Tweak affecté au paramètre Reverb Mix et le réglage Tweak du son Tone 2 peut être affecté au paramètre Delay Mix, ce
qui permet d’utiliser la pédale pour modifier ces deux paramètres simultanément en temps réel ! *Remarque : Il est possible de sauvegarder un Preset Dual Tone avec la Wah activée pour un Tone et désactivée pour l’autre. Si le réglage PEDAL CNTRL est réglé sur BOTH TONES, et si la valeur PEDAL
est “1-W/V” pour les deux sons Tone 1 et 2, le fonctionnement de la pédale reste “lié”. Par conséquent, le fait de cliquer sur le contacteur de la pointe du pied de la pédale active/désactive la Wah de chaque Tone de façon inversée. Vous pouvez régler le statut On/Off de l’effet Wah sur le POD, puis
sauvegarder le Preset. De la même façon, le mode PEDAL “1-W/V” signifie que le contacteur de la pointe du pied de la pédale sélectionne la Wah ou le Volume. Par conséquent, si PEDAL TONE1 et PEDAL TONE2 sont réglés sur “1-W/V”, il est possible de configurer manuellement le statut On/Off de
ces deux effets de façon inverse par Tone, avec pour résultat le fait que le contacteur de la pointe du pied les sélectionne tous les deux à la fois de façon inverse. La morale de cette histoire, c’est que vous pouvez sélectionner exactement la façon de configurer chaque Tone et de sauvegarder vos
Presets utilisateur comme vous le souhaitez ! 2•7 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Comme vous pouvez le voir dans ces exemples, vous pouvez créer des effets vraiment hors du commun en configurant votre(vos) pédale(s) séparément pour les sons Tone 1 et Tone 2 (et les
sons hors du commun sont parfois géniaux !). Il est conseillé de créer plusieurs Presets utilisateur et de sauvegarder les configurations de pédale(s) exactement comme vous souhaitez. Ceci vous permet de charger diverses combinaisons de sons et d’effets, mais aussi différentes méthodes de contrôle
des effets en temps réel. Réglage des paramètres de volume min. et max. de pédale L’effet de volume du POD X3 peut être géré par la(les) pédale(s) du FBV MkII. Le POD X3 offre plusieurs options de gestion du volume. Pour afficher ces régalges, allez dans la page d’accueil du POD X3, sélectionnez
le bloc VOL et double-cliquez sur ON/OFF pour accéder à l’édition du volume : POD X3 — Page du volume • MIN – Détermine le volume lorsque la pédale de volume est au minimum (sur le talon). Réglez sur 0 % pour couper le signal en position haute. • MAX – Détermine le volume lorsque la pédale de
volume est au maximum (sur la pointe). • CONFIG – Vous permet de sélectionner la position de l’effet de volume dans le trajet du signal du POD X3 : Pre (avant Amp+Cab), ou Post (après Amp+Cab). La position de la pédale par rapport aux effets à un impact sur le son. Si vous baissez le volume avant
une distorsion, la saturation baisse. En plaçant le volume après la distorsion, vous pouvez réduire le volume sonore sans réduire la saturation. En position Pre avec un effet de délai, vous pouvez monter le niveau de la guitare et ramener la pédale en arrière pour couper la guitare en acoutant les
répétitions seules. Si vous placez la pédale en position Post, vous coupez la guitare ET les répétitions... Compris ? Notez que le bloc VOL correspond au volume du bouton Tone Volume du POD X3 et, par conséquent, chaque Tone possède son propre effet de VOL indépendant. Ainsi, si votre Preset
possède deux Tones, vous pouvez appuyez sur le bouton TONE 2 pour configurer séparément ces régales pour les sons Tone 1 et Tone 2. Les réglages VOL sont également configurables pour chaque Preset, ce qui vous permet de les sauvegarder avec chaque Preset utilisateur. Gestion des Presets à
doubles sons (Dual Tone) L’une des caractéristiques les plus ingénieuses offertes par le POD X3 est sa capacité à vous offrir deux sons complètement différents en même temps. Il est possible de créer deux sons “Tone”, avec le Tone 1 réglé pour une guitare ou une basse connectée à l’entrée Input 1
du POD X3 et un son Tone 2 créé pour un micro connecté à l’entrée Input 2. De la même façon, vous pouvez créer un mélange des deux sons avec les sons Tone 1 et Tone 2 sur la même entrée, comme si vous aviez une guitare connectée à deux amplis, chaque son possédant ses propres réglages et
effets, enceintes et micro ! Le POD X3 est fourni avec une tonne de Presets à un son, à deux sons séparés et mélangés que vous pouvez sauvegarder dans les Presets utilisateur. Les possibilités sont illimitées. 2•8 Mode d’emploi détaillé des pédaliers FBV MkII — POD X3 Pour obtenir une description



détaillée des sons Dual Tones, consultez la section “Fonction Dual Tone” du Manuel de pilotage du POD X3. Le pédalier FBV MkII vous permet de sélectionner l’une des 128 mémoires du répertoire utilisateur. Comme nous l’avons vu précédemment, certains Presets utilisateur possèdent uniquement un
son Tone 1, et certains autres possèdent un son Tone 1 et un son Tone 2. ceci ne fait aucune différence pour les contacteurs au pied de canaux (A, B, C, D) ou de banque du pédalier, étant donné que le FBV charge simplement un emplacement de canal, que le Preset contienne un ou des Tones. Ceci
dit, il est important de prendre en considération ce que les autres contacteurs au pied du FBV Shortboard MkII contrôlent lorsque vous chargez un Preset Dual Tone... Le pédalier FBV Shortboard MkII est équipé de contacteurs au pied pour les effets (STOMP, MOD, DELAY, etc.) vous permettant de
modifier le son Tone sélectionné dans le Preset chargé. Le fait d’appuyer sur ces contacteurs d’effets active/désactive UNIQUEMENT la fonction du son sélectionné. Vous pouvez configurer le contacteur FUNC 1 du FBV MkII Shortboard pour qu’il agisse comme le bouton TONE 2 du POD X3. Ceci vous
permet de sélectionner le son Tone 1 ou Tone 2 et vous permet de maintenir le contacteur enfoncé pour activer/désactiver la fonction Dual Tone. Pour configurer la fonction du contacteur FUNC 1, affichez le menu SYSTEM du POD X3 et modifiez les options LP SW des sons Tone 1 et Tone 2 (consultez
la description de la fonction LP SW en page 2•6 ). ASTUCE : Lorsque vous chargez un Preset Dual Tone créé en usine de type “Tone Pair”, vous pouvez voir un “L” ou un “R” à la fin des noms de Tone 1 et Tone 2 (chargez le Preset 12A, par exemple). L’ajout d’un caractère au nom de chaque Tone est
très utile avec un pédalier FBV Shortboard, car ceci vous permet de voir sur l’écran LCD du pédalier quel Tone vous êtes en train de contrôler. Voilà ! Armé de ces nouvelles connaissances, vous devriez maintenant pouvoir contrôler au pied, et sans enlever les mains de votre guitare, tous les paramètres
de votre POD X3 ou de votre POD X3 Pro ! Pour de plus amples renseignements, consultez la page Internet Line 6 Online Support. 2•9 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control L’application Line 6 FBV Control Le chapitre de Mise en œuvre devrait vous avoir permis de
commencer à utiliser le pédalier FBV™ MkII. Dans ce chapitre, nous allons vous donner un aperçu des fonctions du logiciel Line 6 FBV Control. Lisez ce chapitre avant de lire les chapitres sur GearBox ou sur les autres applications logicielles, car Line 6 FBV Control est le logiciel qui vous permet de
réaliser toutes ces configurations. Les chapitres qui suivent vous permettent d’en savoir plus sur ce logiciel. Quels sont les avantages ? Votre pédalier FBV Shortboard™ MkII ou FBV Express™ MkII est un équipement sophistiqué, capable de contrôler non seulement les amplis Line 6 et les processeurs
POD® (par connexion RJ-45), mais également quasiment n’importe quel logiciel sur votre ordinateur répondant aux messages de contrôle MIDI (par USB). Le logiciel FBV Control a été conçu à cette fin — il offre des fonctions simples mais puissantes pour vous aider à créer et à personnaliser les types
de messages MIDI transmis à votre logiciel par les contacteurs au pied et les contrôleurs du pédalier. De plus, vous pouvez alors sauvegarder sur votre ordinateur ces affectations de commandes MIDI sous la forme de Presets FBV, et les utiliser à tout moment. Allez-y et modifiez tous les réglages que
vous souhaitez et utilisez votre pédalier FBV MkII pour contrôler toutes les fonctions MIDI de votre logiciel ! Interface graphique utilisateur La fenêtre principale de l’application 6 FBV Control est l’interface graphique utilisateur. Voici comment nous avons organisé la description des éléments importants
que vous devez connaître pour utiliser le logiciel : 3•1 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Contrôleurs 1 - Image du FBV : Représentation graphique de votre pédalier FBV MkII. Pour éditer l’affectation MIDI de tous les contrôleurs de votre pédalier, cliquez directement
sur la représentation graphique du contacteur ou de la pédale. Vous pouvez aussi cliquer dans la liste des propriétés de contrôle. Consultez la liste Control Properties en page 3•2 pour obtenir la description des options d’édition. Remarque : Le logiciel FBV Control détecte automatiquement et sélectionne
le pédalier FBV USB connecté (Shortboard ou Express MkII). Les options sont différentes lorsque vous lancez l’application sans pédalier FBV connecté (ou si plusieurs pédaliers sont connectés). Consultez les «Préférences» en page 3•9. 2 - Contacteurs au pied : Cliquez directement sur n’importe quel
contacteur pour le sélectionner ainsi que sa rangée dans la liste des paramètres de contrôle (cette liste vous permet d’éditer son affectation MIDI). Tous les contacteurs de votre pédalier FBV MkII peuvent être affectés à n’importe quel type de réglage MIDI disponible dans la liste Control Properties, quel
que soit le nom du contacteur sur le pédalier FBV. Si vous ne souhaitez pas qu’un contacteur transmette des données MIDI sélectionnez “Unassigned” dans la colonne de commande MIDI (consultez «Fonctionnement des Leds de contacteurs au pied» en page 3•6 pour en savoir plus sur les témoins
lumineux). 3 - Pédales Wah et Vol : Ces contacteurs vous offrent deux fonctions affectables à la pédale de votre pédalier FBV (“Pédale 1”). Pour éditer les affectations aux fonctions de la Pédale 1, cliquez directement sur les zones WAH ou VOL de l’image (ou directement dans les rangées du tableau
Control Properties). Vous pouvez assigner chacune des deux fonctions de la Pédale 1 pour qu’elles transmettent n’importe quelle valeur de CC MIDI et contrôler deux paramètres différents de votre application en enfonçant la pédale complètement sur la pointe et en activant le contacteur de fin de course
avant. Consultez également la description suivante sur le contacteur de fin de course de la pédale. Lorsque la Led WAH est allumée sur votre pédalier FBV, cela indique que l’affectation “Wah” de la Pédale 1 est en cours d’utilisation. Lorsque la Led VOL est allumée, l’affectation “Vol” de la Pédale 1 est
utilisée. 4 - Contacteur de fin de course de la pédale 1 : Cliquez pour sélectionner le contacteur de fin de course, “le contacteur de pointe du pied” situé sous la partie inférieure à l’avant de la pédale. Ce contacteur a deux fonctions : • Ce contacteur peut être assigné à n’importe quelle commande MIDI,
comme les autres contacteurs du FBV. Ceci est pratique pour commander certains paramètres liés à la pédale. • De plus, ce contacteur vous permet de faire passer la Pédale 1 en “Wah” ou en “Volume”, selon la configuration dans la liste Control Properties. Les Leds WAH et VOL s’allument sur le FBV
selon la fonction sélectionnée. Le contacteur de fin de course remplit toujours cette fonction, quelles que soient les options du contacteur de pointe du pied de la liste Control Properties. Ce contacteur ne transmet pas de données MIDI. La seule commande MIDI transmise par le contacteur de pointe de
pied est celle que vous avez assignée dans la liste Control Properties. Voyez également : “3 - Pédale de Wah et de Vol” pour en savoir plus sur les réglages de pédales. 5 - Pédale 2 (Shortboard uniquement) : Le pédalier FBV Shortboard MkII est équipé d’une embase Jack “Expression Pedal” à l’arrière
pour la connexion d’une pédale d’expression optionnelle (Line 6 EX-1, par exemple). Pour éditer les affectations de la pédale d’expression, cliquez directement sur la zone de la pédale 2 de l’image, ou dans la rangée Pedal 2 de la liste Control Properties. Vous pouvez configurer la pédale 2 pour
transmettre n’importe quel CC MIDI et n’importe quelle valeur pour commander ou gérer un “bouton” ou un “curseur” dans l’application contrôlée par le pédalier. 6 - Liste Control Properties : Cette liste affiche tous les contacteurs et pédales qui peuvent être édités sur votre pédalier FBV
Shortboard/Express MkII. Comme nous l’avons déjà mentionné, vous pouvez 3•2 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control cliquer directement sur un contrôleur (sur la représentation graphique du pédalier), ou vous pouvez cliquer sur n’importe quelle rangée de la liste
Control Properties List pour le sélectionner et éditer ses paramètres MIDI. Voici la description de chaque colonne et des options offertes... • Control : Nom du contacteur ou de la pédale physique, tel que sérigraphié sur le FBV MkII. Notez que ceci n’est qu’un nom pour le contrôleur. Vous pouvez choisir
n’importe quelle commande MIDI pour chaque contacteur au pied ou pédale, quel que soit le nom. • MIDI Command : Type de message MIDI transmis par le contrôleur. Vous pouvez choisir les commandes MIDI suivantes pour tous les contacteurs (notez que les contrôles Pedal Wah, Pedal Vol, et la
pédale 2 permettent uniquement la transmission de messages de CC MIDI ou affichent les options Unassigned) : • Unassigned : Ne transmet aucune donnée MIDI. Désactive le contrôleur. Si vous prévoyez de ne pas utiliser certains contacteurs au pied ou pédales à l’intérieur de votre Preset, il est
conseillé d’utiliser l’option Unassigned pour éviter de déclencher accidentellement des fonctions dans votre application ! • Bank Change : Valeur utilisée pour faire défiler les banques de Presets. • Program Change : Valeur pour sélectionner un Preset dans la banque. • Contrôleurs Continus MIDI (MIDI
CC) : Valeurs et plages de valeurs utilisées par les logiciels et équipements MIDI pour accéder aux paramètres. • MIDI Machine Control (MMC) : Commandes de gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.). • Mackie : Commandes au format “Mackie
Universal Controller”, utilisées pour la gestion des paramètres de transport et des fonctions mécaniques (Play, Stop, Record, etc.) sur les logiciels MIDI compatibles avec le format Mackie Control. Remarque : Les pédaliers FBV MkII ne transmettent que ces commandes MIDI. Ils ne peuvent pas
transmettre de messages de notes MIDI ou de messages de Dumps SysEx MIDI. Value : Vous permet de sélectionner une valeur MIDI pour la commande MIDI sélectionnée. Ces options varient avec le type de commande MIDI sélectionné (voir ci-dessus). • Si la commande MIDI est de type Bank
Change ou Program Change, avec Increment ou Decrement sélectionné comme mode de contacteur Switch Mode, vous pouvez sélectionner une valeur de 1 à 127* pour le défilement des Banques/Presets à chaque clic. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes
de banque ou de Program Change lorsque vous configurez le mode Increment/Decrement Switch Modes. Ceci dit, cette valeur n’est pas recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Si la commande MIDI est de type Bank Change ou Program Change,
avec une valeur Fixed sélectionnée pour le mode Switch Mode, vous pouvez sélectionner n’importe quelle valeur de 0 à 127 pour passer directement à la Banque/Preset correspondant à la valeur. • Si la commande MIDI est de type MIDI CC, vous pouvez sélectionner une valeur de 0 à 127, ou Custom.
Si vous sélectionnez Custom, les options Toggle 1/Sup. et Toggle 2/Inf. de la rangée sont accessibles, et chaque action de contact Toggle peut être configurée avec une valeur propre de CC MIDI. • Si la commande MIDI est de type MMC, vous pouvez sélectionner les options Play, Stop, Play/ Stop,
Record Punch-Pro Tools, Pause, Fast Forward, ou Rewind. • Si la commande MIDI est de type Mackie, vous pouvez sélectionner les options Play, Stop, Play/ Stop, Record Punch, Pause, Fast Forward, ou Rewind. 3•3 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Colonnes
Toggle1/Sup. Toggle2/Dn CC/Val : Ces colonnes apparaissent lorsque la commande MIDI est réglée sur “MIDI CC” et la valeur est réglée sur “Custom”. Les valeurs peuvent être saisies manuellement pour définir la réaction des options de contacteurs Toggle 1/Sup. et Toggle 2/Inf (voir «Fonctionnement
des contacteurs au pied» en page 3•5 pour de plus amples détails). Port : Sélectionne le port de sortie des données MIDI du logiciel FBV Control. Le pédalier FBV MkII offre quatre ports USB MIDI Out indépendants sélectionnables par les logiciels MIDI installés sur votre ordinateur (pour la réception des
données MIDI transmises par le pédalier FBV). Vous pouvez sélectionner individuellement les ports 1, 2, 3, 4 ou tous à la fois (All) pour n’importe quel contrôle. ASTUCE : Si vous souhaitez utiliser votre pédalier FBV avec plusieurs applications en même temps, vous pouvez régler les contrôles sur
différents ports avec chaque application configurée pour recevoir les données sur son propre port MIDI. Channel : Canal MIDI de transmission des données sur le port sélectionné. Vous pouvez sélectionner n’importe quel canal de 1 à 16. Si vous avez sélectionné l’option “All” dans la colonne des Ports,
la valeur de canal MIDI courant est utilisée pour les quatre ports MIDI. Switch Mode : Ces options dépendent de la commande MIDI sélectionnée (il n’y a pas d’option Switch Mode pour les contrôleurs Pédale Wah, Pédale Vol, ou pédale 2). • Si le paramètre MIDI Command est réglé sur Bank Change ou
Program Change, les options disponibles sont Increment, Decrement, ou Fixed : • Increment : Configure le contacteur pour incrémenter les Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. • Decrement : Configure le contacteur pour décrémenter les
Banques/Programmes d’une valeur de 1 à 127*, selon la valeur de la colonne Value. *Remarque : Il est possible de sélectionner une valeur de “0” pour les commandes Bank ou Program Change lorsqu’elles sont configurées en mode Increment/Decrement Switch. Ceci dit, cette valeur n’est pas
recommandée étant donné qu’elle n’est pas compatible avec la majorité des applications MIDI. • Fixed : Configure le contacteur pour passer directement à un n° spécifique de Banque/ Programme de 0 à 127, selon la valeur de la colonne Value. Remarque : Toutes les commandes FBV de changement
de banque transmettent également un Program Change dans le message MIDI. De cette façon, le premier Preset de la nouvelle banque est automatiquement chargé. Par exemple, si votre logiciel est sur la banque n° 1 et le Preset n° 23, et si votre FBV Control est configuré pour transmettre une valeur
d’incrémentation de 1, vous chargez la banque n° 2 et le Preset n° 1 dans l’application logicielle cible. • Si la commande MIDI est un CC MIDI, les options sont Single, Momentary, ou Toggle. Consultez également «Fonctionnement des contacteurs au pied» en page 3•5. • Si la commande MIDI est de type
MMC ou Mackie, il n’y a pas d’option Switch Mode. Ceci dit, certaines commandes MMC et Mackie se configurent automatiquement en tout-ou-rien comme “Lecture/Arrêt”, et alternent entre les deux messages. 7 - No Line 6 Device Connected : Si aucun pédalier FBV MkII n’est détecté lorsque vous
lancez l’application FBV Control, ce message s’affiche, vous indiquant que le pédalier n’est pas relié à l’ordinateur par le câble USB, ou qu’il y a un problème de détection du pédalier: 3•4 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Si le pédalier FBV est déconnecté, vous
pouvez le connecter au port USB de votre ordinateur pendant que l’application FBV Control est toujours ouverte : l’application le détecte alors automatiquement. Note aux utilisateurs de Windows®... Le pilote USB de Windows® XP, Windows® 7 et de Windows Vista® USB ne permet qu’à une seule
application à la fois d’utiliser le port MIDI d’un périphérique USB MIDI. L’application Line 6 FBV Control utilise le port MIDI In du FBV pour transmettre vos réglages au pédalier FBV. Par conséquent, évitez de configurer votre logiciel logiciel MIDI/audionumérique pour qu’il utilise le port MIDI In du FBV si
vous souhaitez ouvrir FBV Control en même temps pour communiquer avec le pédalier FBV (vous n’avez besoin que de l’un des ports de sorties MIDI Out FBV 1 à 4 avec votre application MIDI/audionumérique pour recevoir les messages MIDI en provenance du FBV). Fonctionnement des contacteurs
au pied Comme nous l’avons vu à la section sur la liste Control Properties en page 3•2, les contacteurs au pied du FBV MkII offrent plusieurs modes de fonctionnement selon le type de commande MIDI et la valeur sélectionnés. Lorsque vous sélectionnez MIDI CC comme type Command MIDI, vous avez
le choix entre trois différents modes de commutation ; Single, Toggle, ou Momentary. Chaque contacteur peut transmettre une ou deux commandes de CC MIDI (selon le mode Switch Mode), ce qui est pratique pour certains paramètres de certains logiciels. Certains fabricants de logiciels utilisent un
mode de commutation ou l’autre pour leurs paramètres, alors consultez le mode d’emploi de l’application pour déterminer le meilleur mode. Voici quelques exemples de fonctionnement de ces trois modes... Pour cet exemple, prétendons que vous ayez sélectionné les options suivantes pour le contacteur
“A” : En sélectionnant la valeur “065”, vous réglez les affectations de CC MIDI du contacteur au pied sur le CC n° 65. À droite, vous pouvez voir l’information dans les champs CC et Val des colonnes “Toggle 1/ Sup.” et “Toggle 2/Inf.” (même si vous ne pouvez pas les modifier, vous pouvez voir les
valeurs utilisées). Les valeurs sont automatiquement configurées sur 127 et 0. Avec ces valeurs, le fonctionnement de chaque Switch Mode est le suivant : • Single : Transmet toujours uniquement le n° de CC et la valeur Toggle 1/Sup. CC lorsque vous appuyez sur le contacteur (CC 65 et valeur 127
dans notre exemple). • Toggle : Alterne les premiers et seconds paramètres de CC et de valeur avec chaque pression successive sur le contacteur au pied (commutateur tout-ou-rien). Ainsi, dans notre exemple, CC 65/127 sont transmis lors de la première pression sur le contacteur au pied, et CC 65/0
sont transmis lors de la seconde. Certains paramètres de logiciels utilisent ce mode de commutation comme pour la sélection On/Off d’une fonction. En général, les valeurs 0 - 64 modifient l’état du paramètre, et la valeur 65 - 127 inverse l’état. Ceci dit, vous vous rendrez compte que certains logiciels
utilisent les commandes de CC MIDI avec le mode Momentary pour modifier le statut d’un paramètre. Consultez le mode d’emploi du logiciel (ou essayez divers modes de commutation) pour voir le mode qui convient le mieux à votre application. • Momentary : Transmet les premières informations CC &
Value lorsque vous appuyez sur le contacteur, et les deuxièmes informations CC & Value lorsque vous relâchez le contacteur. Ce type de commutation est en général utilisé avec les paramètres comme la pédale de Sustain d’un piano, avec la fonction active uniquement lorsque le contacteur est enfoncé,
et désactivée lorsque le contact est ouvert. Dans notre exemple, vous transmettez les données CC65/127 en appuyant sur le contacteur, et les données CC65/0 lorsque le contacteur est relâché. 3•5 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control MIDI CC - Option Custom : De
plus, lorsque vous sélectionnez une commande de type CC MIDI, vous pouvez également choisir l’option “Custom” au lieu d’un n° de CC dans le champ Value. Ceci vous permet d’éditer les champs “Toggle1/Sup.” et Toggle 2/Inf.” pour saisir manuellement les premières et secondes valeurs CC et Value.
Comme nous l’avons vu précédemment, les options Momentary et Toggle Switch permettent au contacteur au pied de transmettre chacune de ces valeurs de CC, en alternant. C’est très utile si vous souhaitez réaliser des actions très spécifiques, comme pour alterner un paramètre du logiciel en
appuyant sur un contacteur au pied, et ensuite un autre paramètre en appuyant à nouveau sur le contacteur. ASTUCE pour le Shortboard MkII : Lorsque vous appuyez sur un contacteur ou lorsque vous déplacez une pédale, l’écran LCD du FBV affiche également le nom abrégé du message MIDI
transmis. Fonctionnement des Leds de contacteurs au pied Chaque contacteur au pied du pédalier FBV MkII dispose d’une Led. Lorsque vous connectez le FBV par USB, ces Leds s’allument selon le type de commande MIDI et de mode de commutateur (Switch Mode) transmis par ce contacteur. En
général, les réglages Switch Mode suivants impliquent les fonctionnements de Leds suivants : • Le réglage Switch Mode “Single” allume la Led à chaque pression sur le contacteur au pied. La Led ne reste pas allumée lorsque vous relâchez le contact, ce qui indique que la même valeur MIDI est
transmise à chaque pression sur le contacteur au pied. • Avec le réglage Switch Mode “Toggle”, la Led reste allumée ou éteinte à chaque pression successive sur le contacteur au pied, et indique que des valeurs MIDI alternatives sont transmises à chaque pression sur le contacteur au pied. • Dans le cas
des commandes de type CC MIDI, la valeur de CC MIDI de 0 à 64 signifie “On”, avec la Led restant allumée. Une valeur de CC MIDI de 65 à 127 signifie “Off”, et la Led reste éteinte. • Comme dans le cas de la configuration de contacteur “Toggle” évoquée précédemment, le mode “Momentary” transmet
également deux valeurs de CC. Ceci dit, le réglage “Momentary” allume la Led pendant la pression sur le contacteur au pied, correspondant au statut “On” de la valeur MIDI transmise. La Led s’éteint lorsque vous relâchez le contact, indiquant le statut “Off” de la valeur. • Lorsque le contacteur au pied est
réglé sur “Unassigned”, la Led du contacteur au pied ne s’allume jamais (pression sur le contact ou non), et indique qu’aucun message n’est transmis. • Pour tous les autres réglages, la Led des contacteurs au pied s’allume uniquement avec la pression sur le contact et s’éteint lorsque vous relâchez la
pression sur le contacteur. Il est important de noter que le fonctionnement des Leds est basé uniquement sur les réglages évoqués plus haut, et configurés dans la liste Control Properties. Les pédaliers FBV MkII ne reçoivent pas et ne répondent pas aux données MIDI transmises par votre logiciel
MIDI/audionumérique. 3•6 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Fonctionnement des pédales La pédale intégrée du pédalier FBV MkII (ainsi que la pédale d’expression externe du FBV Shortboard MkII) permet de transmettre des messages MIDI de CC, avec des
valeurs comprises entre 0 et 100 %. Évidemment, le contrôle par la pédale est mieux adapté à la gestion d’un bouton ou d’un curseur dans votre logiciel, ce qui vous permet de modifier le paramètre au pied en temps réel. Il est facile d’affecter une pédale à un réglage. Il vous suffit de sélectionner la
valeur MIDI CC comme commande MIDI, puis de sélectionner le n° de CC MIDI qui correspond au paramètre cible dans le logiciel. La plage de valeurs de 0 à 127 est automatiquement saisie pour vous, permettant un réglage de 0 à 100 % du paramètre contrôlé (certaines applications MIDI vous
permettent de saisir des valeurs minimum et/ou maximum différentes à l’intérieur du logiciel. Consultez le mode d’emploi de votre logiciel. Notez que votre pédalier possède deux réglages dans la liste Control Properties : Pedal Wah et Pedal Vol. Vous pouvez régler ces contrôles séparément, et utiliser le
contacteur de pointe du pied commuter entre deux paramètres ! Consultez la section sur la pédale de Wah et de Vol en page 3•2 . Ouverture et sauvegarde des Presets FBV L’application 6 FBV Control vous permet de créer, éditer et sauvegarder tous les réglages sous la forme d’un Preset FBV
sauvegardé sur le disque dur de votre ordinateur. Cela signifie que vous pouvez sauvegarder la totalité des réglages en mémoire dans le pédalier FBV Shortboard ou Express MkII, ou sauvegarder plusieurs versions personnalisées de ces réglages, sous la forme de Presets FBV. Vous pouvez ensuite
chargez le Preset que vous souhaitez dans la mémoire de votre pédalier FBV. Nous vous fournissons plusieurs Presets FBV. Voici comment gérer les Presets FBV. Comme nous l’avons vu, lorsque votre pédalier FBV MkII est connecté par USB à votre ordinateur, l’application FBV Control se lance avec
le pédalier correspondant déjà sélectionné — le contenu de la mémoire du pédalier est automatiquement chargé dans l’interface graphique de FBV Control. De plus, lorsque vous modifiez n’importe quel réglage dans FBV Control, les modifications sont automatiquement transférées dans la mémoire
interne du pédalier FBV MkII. ASTUCE : Même si tous les réglages faits dans FBV Control sont sauvegardés dans le pédalier FBV, il est conseillé de toujours faire un “Save” ou “Save As” de vos réglages sous la forme d’un Preset FBV sur votre ordinateur une fois que vous avez terminé l’édition dans
FBV Control. Ceci vous permet de conserver un “Backup” de ces réglages dans un fichier .fbv ! Si vous souhaitez ouvrir un fichier de Preset FBV, l’essayer ou l’éditer sans automatiquement charger le Preset dans la mémoire interne du pédalier FBV MkII, déconnectez le pédalier FBV du port USB avant
de lancer le logiciel FBV Control. Ouverture d’un Preset FBV • Une fois le pédalier FBV Shortboard ou Express MkII connecté au port USB de votre ordinateur, lancez FBV Control. • Allez dans File > Open. • Par défaut, vous devriez accéder aux répertoires suivants : • Documents/Line 6/FBV (Mac®) •
Mes Documents\Line 6\FBV (Windows®) • Dans ces dossiers, vous trouverez les Presets FBV “d’usine” fournis (par exemple, “FBV-Default. fbv”). 3•7 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control • Ceci charge le Preset FBV dans l’application FBV Control et le charge
automatiquement dans la mémoire interne du pédalier FBV MkII. Notez que votre pédalier FBV Shortboard/Express MkII contient un Preset FBV complet à la fois. Lorsque vous ouvrez un nouveau fichier de Preset comme nous l’avons décrit, celui-ci REMPLACE toutes les affectations de contrôleurs
USB MIDI dans la mémoire interne de votre pédalier FBV par celles du nouveau fichier .fbv. Avant d’ouvrir un nouveau fichier de Preset, lancez un Save ou un Save As du Preset courant sur votre ordinateur pour pouvoir recharger les réglages plus tard. Sauvegarde d’un Preset FBV Lorsque vous
travaillez dans FBV Control, vous pouvez à tout moment sauvegarder tous les réglages courants depuis le logiciel FBV Control sous la forme d’un Preset FBV sur le disque dur de votre ordinateur. Sauvegardez dès que vous souhaitez réutiliser plus tard des réglages (pensez à sauvegarder souvent !).
Procédures standards de sauvegarde sous Mac® et Windows®... • Pour sauvegarder les modifications apportées au Preset FBV, et remplacer les anciens réglages par les nouveaux, sélectionnez File > Save. • Pour sauvegarder les modifications apportées au Preset FBV sous la forme d’un nouveau
fichier FBV, sélectionnez File > Save As. Le logiciel vous demande alors de nommer le fichier, et où vous souhaitez le sauvegarder. Pour garder vos fichiers FBV organisés et faciles à trouver, sauvegardez- les dans le dossier où sont installés les Presets d’usine lors de l’installation : • Documents/Line
6/FBV (Mac®) • Mes Documents\Line 6\FBV (Windows®) ASTUCE : Le nom du Preset courant chargé possède un astérisque à la fin du nom (par exemple “mon Preset.fbv*”) en haut de la fenêtre d’application lorsque le Preset n’a pas encore été sauvegardé. Édition et sauvegarde des Presets FBV sans
pédalier FBV connecté Il n’est pas nécessaire que votre pédalier FBV Shortboard/Express MkII soit connecté par USB pour utiliser l’application FBV Control et éditer ou sauvegarder les fichiers de Preset. Vous pouvez toujours procéder comme indiqué plus haut pour ouvrir (Open), sauvegarder (Save)
ou sauvegarder sous (Save As) un Preset FBV sur votre ordinateur. Ceci peut être très pratique si vous souhaitez éditer vos Presets FBV sans charger le Preset dans la mémoire interne de votre pédalier FBV. Pour charger ces Presets dans la mémoire interne de votre pédalier FBV MkII, vous devez
connecter le FBV au port USB de votre ordinateur, et ouvrir un Preset FBV sauvegardé pour qu’il soit chargé dans la mémoire du pédalier FBV. Lorsque vous lancez l’application FBV Control sans pédalier FBV MkII connecté, indiquez à l’application le type de pédalier à charger à l’écran (Shortboard ou
Express MkII). Ceci nous permet de faire une transition parfaite vers le chapitre suivant sur les préférences de l’application ! 3•8 Mode d’emploi détaillé des pédaliers FBV MkII — Logiciel FBV Control Préférences Comme c’est le cas avec la plupart des applications, nous avons placé les réglages
généraux dans les préférences. Pour afficher la fenêtre des préférences de 6 FBV Control : • Mac® - Line 6 FBV Control > Preferences • Windows® - File > Preferences Lorsque le pédalier n’est pas connecté Lorsque l’ordinateur ne détecte aucun pédalier FBV connecté lors du démarrage, le logiciel FBV
Control peut afficher pour vous un pédalier FBV Shortboard ou un pédalier Express MkII. Par défaut, le logiciel vous demande toujours quel pédalier sélectionner. Pour éviter la question, sélectionnez le pédalier que vous souhaitez voir chargé. Sinon, sélectionnez la case “Do this every time” en bas de la
boîte de dialogue. Vous pouvez modifier les préférences quand vous le souhaitez. Notez que ceci n’influence pas la façon dont se lance l’application FBV lorsque votre pédalier FBV MkII est connecté : le pédalier FBV connecté s’affiche automatiquement à l’écran. De plus, si vous avez plusieurs
pédaliers FBV MkII connectés à votre ordinateur en même temps (par exemple, un Shortboard et un Express MkII), l’interface vous demande de sélectionner le pédalier avec lequel vous souhaitez travailler. Case Show Warning Dialog at Startup Cette case vous demande si vous souhaitez voir la fenêtre
de mise en garde lors du lancement du logiciel FBV Control, vous informant sur le fait que les changements apportés au logiciel prennent effet immédiatement dans le pédalier FBV connecté (désolé de répéter, mais c’est vraiment important !). Si vous ne souhaitez pas voir la mise en garde, veillez à ne
pas sélectionner cette case dans le menu Preferences. Ou, si vous avez coché la case “Don’t show again” alors que vous souhaitez être mis en garde, allez dans le menu Preferences et cochez la case. Lisez le message avant de désactiver cette option, promis ? 3•9 Mode d’emploi détaillé des pédaliers
FBV MkII — Logiciel FBV Control Fenêtre ‘About Line 6 FBV Control Application’ Cette fenêtre vous donne des informations sur l’application. Pour l’ouvrir : • Mac® - Line 6 FBV Control > About Line 6 FBV Control • Windows® - Help > About Line 6 FBV Control Maintenant, vous pouvez voir les
informations suivantes : • La version de l’application Line 6 FBV Control. • Le pédalier FBV MkII qui est détecté et utilisé par l’application (ou “None”, si aucun pédalier FBV n’est connecté). • Le Firmware du pédalier FBV MkII connecté. • Certaines infos de droits d’auteur imposées par nos avocats.
Cliquez n’importe où dans la fenêtre pour la fermer. ASTUCE : Souvenez-vous que vous pouvez lancer Line 6 Monkey avec le pédalier FBV connecté à l’ordinateur pour installer les dernières versions du logiciel et du Firmware ! L’écran LCD du pédalier FBV Shortboard MkII Lorsque vous connectez le
pédalier FBV Shortboard MkII au port USB de votre ordinateur, l’écran LCD affiche “USB MODE” pour indiquer que le FBV est prêt à être utilisé comme contrôleur USB MIDI. À chaque fois que vous appuyez sur le contacteur au pied ou que vous bougez une pédale, l’écran LCD affiche le message MIDI
transmis. Le texte reste affiché jusqu’à ce que vous appuyiez sur un autre contacteur au pied ou sur une autre pédale. Par exemple, l’écran peut indiquer le message suivant de transmission de message de CC MIDI : CH 1 CC 111 VAL 127 Cela signifie que les données sont transmises sur le canal MIDI
1, avec un message de CC MIDI n° 111, une valeur de CC de 127. Si le mode Switch de ce contrôleur est “Toggle”, la valeur de CC alterne avec chaque pression successive sur les valeurs de CC Toggle 1 et Toggle 2 (indiquées dans la liste Control Properties). Lorsque vous utilisez une pédale, vous
pouvez voir la valeur du CC MIDI varier en temps réel, indiquant les données transmises par la pédale. De la même façon, les autres commandes MIDI sont affichées à l’écran LCD (par exemple, “MMC PLAY” pour indiquer un message MMC, ou “CH 1 PGM 1” pour indiquer un Program Change). 3•10
Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 FBV™ MkII et POD Farm™ 2 Line 6 Ce chapitre est dédié à l’utilisation du pédalier Line 6 FBV Shortboard™ MkII ou FBV Express™ MkII pour le contrôle des paramètres de l’application autonome Line 6 POD Farm™ 2 et du Plug-In POD
Farm™ 2. Ceci vous permet d’étendre les possibilités de POD Farm 2 en utilisant les fonctions du FBV MkII pour assigner la pédale au contrôle de l’effet Wah, du Volume ou du Pitch Bender, pour activer/désactiver n’importe quel effet, pour faire défiler les Presets du POD Farm 2, pour contrôler les
paramètres du Plug-In POD Farm 2 tout en enregistrant les automations de votre station d’enregistrement audionumérique, et bien plus encore ! Si cela n’est pas déjà fait, connectez le pédalier FBV Shortboard ou Express MkII au port USB de votre ordinateur et lancez Line 6 Monkey™ pour vous
assurer que le FBV possède le dernier Firmware disponible - consultez «Mise à jour et enregistrement avec Line 6 Monkey» en page 1•1. Qu’est-ce que le POD Farm 2 ? Au cas où vous vous demanderiez... Le POD Farm 2 Line 6 est le logiciel offert aux utilisateurs des interfaces USB de Line 6*.
L’application autonome POD Farm 2 offre une interface utilisateur graphique complète vous permettant d’accéder à tous les célèbres modèles Line 6 d’amplis guitare/ basse, préamplis, enceintes, micros, et effets. En utilisant votre interface audio USB Line 6, ceci vous permet de bénéficier des sons du
POD directement sur votre ordinateur, et vous pouvez les utiliser pour vos enregistrements avec votre logiciel audionumérique. De plus, le POD Farm 2 est également fourni avec le Plug-In POD Farm 2 et les Plug-Ins POD Farm Elements, utilisables comme effets audio par la plupart des applications
d’enregistrement audio sur Mac® et avec Windows®. L’application autonome POD Farm 2 et le Plug-In POD Farm 2 sont gérables de façon externe par MIDI, et votre pédalier FBV MkII est le contrôleur USB MIDI de choix pour cette tâche ! *Remarque : L’application autonome POD Farm 2 nécessite
l’utilisation d’un POD Studio™, d’un TonePort™ ou d’un GuitarPort™ Line 6. Vous pouvez aussi acheter une license POD Farm 2 comme “supplément” à votre POD®xt, POD® X3 Line 6 ou pour une clef USB iLok pour que le Plug-In POD Farm 2 tourne avec ces processeurs. Pour acheter le POD Farm
2, connectez votre interface audio USB Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe vous guider pour le téléchargement. Ou allez directement à la page et téléchargez-le. Si cela n’est pas déjà fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous
en aurez besoin pour charger et éditer les informations de contrôle MIDI dont votre FBV à besoin pour communiquer avec le POD Farm 2. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les informations de téléchargement. À propos des ports et canaux USB MIDI Pour
commencer, il est utile de comprendre comment les communications MIDI fonctionnent entre le FBV MkII et l’ordinateur. Une fois connecté à un port USB de votre ordinateur Mac® ou Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces
ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Si vous contrôlez l’application autonome POD Farm 2, vous accédez aux ports FBV MIDI depuis les Préférences de l’application
autonome POD Farm 2 (voir «POD Farm 2 Standalone Application - MIDI Input Configuration» en page 4•7). Si vous contrôlez le Plug-In POD Farm 2, vous devez configurer l’application hôte dans laquelle vous utilisez le Plug-In pour recevoir le MIDI de ces ports FBV MkII MIDI (voir «POD Farm 2 Plug-
In - MIDI Input Configuration» en page 4•8). 4•1 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Communication MIDI avec l’application logicielle Une fois le pédalier FBV MkII connecté par USB à l’ordinateur, vous devez configurer votre application en réception des données de contrôle
MIDI sur le port MIDI Out et le canal MIDI du FBV. Par exemple, dans Ableton Live® ou Live® Lite, le menu Preferences > MIDI/Sync offre des options entre plusieurs contrôleurs MIDI. Dans l’application MIDI/audio hôte, vous pouvez voir les ports FBV MIDI 1 à 4 pour la réception des données de
contrôle MIDI. Remarque : Le nom exact de ces ports varie sous Mac OS® X, Windows® 7, Windows Vista® et Windows® XP - Veuillez consulter les exemples des chapitres suivants. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous
pouvez régler chaque contrôle du pédalier FBV pour qu’il transmette sur les ports FBV MIDI Out 1 à 4 (voir la section sur la liste des propriétés de FBV Control en page 3•1). Communication des ports MIDI sous Windows® Il est important de noter que le pilote universel USB Windows® qui est utilisé pour
votre pédalier FBV MkII sous Windows® 7, Windows Vista® et XP®, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV.
Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à communiquer. Si le POD Farm 2 en version autonome ou votre application
audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV MIDI In et du port FBV MIDI Out 4 dans
votre application MIDI/ audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez toutes les applications
MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de quitter FBV Control, et
toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la
regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal
MIDI (consultez la section sur la liste des propriétés de FBV Control en page 3•1). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné : configurez ces options de canal MIDI sur le canal de transmission de FBV Control.
Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. 4•2 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Affectations MIDI pré-configurées de POD Farm 2 L’application autonome POD Farm 2 et le Plug-In POD Farm 2 offrent une palette
complète de Presets de sons avec des affectations MIDI “pré-configurées”. Pour accéder à ces Presets, sélectionnez le répertoire “POD Farm 2” dans la zone Source Folders de la fenêtre Presets View. Sélectionnez le répertoire “POD Farm 2” (ou sous-répertoire) dans la zone Source Folders Les
Presets de sons disponibles dans ces répertoires ont des affectations de gestion MIDI “pré-configurées” Fenêtre des Presets de POD Farm 2 Les affectations MIDI pré-configurées permettent à n’importe quel contrôleur MIDI d’accéder aux paramètres des ces sons du POD Farm 2. Notez que ces deux
affectations MIDI des sons sont des affectations MIDI “Locales” - ce qui signifie qu’elles sont sauvegardées individuellement avec chaque Preset de son, et accessibles dans le POD Farm 2 en version Plug-In ou autonome. De plus, l’application autonome POD Farm 2 dispose de plusieurs affectations
MIDI “Globales” pré-configurées. Ces affectations MIDI Globales, sont configurées pour le POD Farm 2. Elles sont disponibles, quel que soit le Preset de son sélectionné, et restent actives (il n’est pas nécessaire de sauvegarder les sons pour les conserver). Avec un pédalier Line 6 FBV MkII, nous
avons simplifié les choses en fournissant le Preset “POD Farm 2” FBV Control pour configurer le pédalier FBV en contrôle de ces sons (voir section suivante). Presets de contrôle du “POD Farm 2” par le pédalier FBV MkII Pour vous aider à utiliser votre pédalier FBV MkII avec POD Farm 2, nous avons
créé les Presets “POD Farm 2” FBV MkII que vous pouvez charger dans votre pédalier FBV MkII avec le logiciel Line 6 FBV Control. Ces Presets de contrôle FBV MkII (fichiers .fbv) chargent un jeu complet de commandes MIDI pour chaque contacteur au pied et chaque pédale du pédalier avec gestion
des fonctions de POD Farm 2 ! Il est conseillé de télécharger et de charger le Preset FBV Control dans votre pédalier FBV MkII avant de configurer l’application autonome ou le Plug-In POD Farm 2 ou le contrôleur FBV MkII. Ces Presets FBV MkII sont en téléchargement sur le site l’aide en ligne de POD
Farm : • Pour le FBV Shortboard MkII - Téléchargez le fichier “POD Farm 2-Shortboard.fbv”. • Pour le FBV Express MkII - Téléchargez le fichier “POD Farm 2-Express.fbv”. Une fois que vous avez téléchargé le Preset FBV Control de votre pédalier, lancez l’application Line 6 FBV Control pour charger le
Preset dans votre pédalier FBV MkII : • Mac® : allez dans /Applications/Line 6 et double-cliquez sur Line 6 FBV Control • Windows® : allez dans de Démarrer\Programes\Line 6\Line 6 FBV Control 4•3 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Pour de plus amples renseignements sur
l’application Line 6 Control, consultez le chapitre “L’application Line 6 FBV Control” en page 3•1. Ceci charge automatiquement les réglages de contrôle MIDI du “POD Farm 2” dans la mémoire du pédalier FBV MkII. Ces réglages de contrôle FBV vous permettent d’accéder instantanément à des
affectations MIDI “pré-configurées” très utiles qui existent déjà dans le POD Farm 2 (voir les chapitres précédents). Vous pouvez voir les affectations MIDI de n’importe quel Preset de son POD Farm 2 dans la fenêtre POD Farm 2 “MIDI Assignments” (voir «Fenêtre des affectations MIDI de POD Farm 2»
en page 4•10). Les réglages MIDI Bank et Program Change sont également fournis dans le Preset FBV MkII ce qui vous permet d’utiliser les contacteurs au pied pour naviguer dans les listes et les Presets de sons du POD Farm 2. De plus, vous pouvez personnaliser ces affectations MIDI de façon
individuelle pour chaque son POD Farm 2, et/ou utiliser la fonction “d’apprentissage MIDI” du POD Farm 2 pour créer facilement vos propres affectations MIDI (voir «Fonction d’apprentissage MIDI Learn de POD Farm 2» en page 4•10). Une fois le Preset de contrôle FBV MkII “POD Farm 2” chargé dans
votre pédalier FBV Shortboard ou Express MkII, la liste Control Properties de FBV Control affiche tous les réglages MIDI. Pédalier FBV Shortboard MkII Réglages du Preset POD Farm 2-Shortboard.fbv, une fois chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Shortboard MkII
contrôlent ainsi le POD Farm 2 : Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Banque supérieure Preset de son suivant dans la liste sélectionnée Banque inférieure Preset de son précédent dans la liste sélectionnée A Liste 0, et Preset de son “0” dans la liste B
Liste 1, et Preset de son “0” dans la liste C Liste 2, et Preset de son “0” dans la liste D Liste 3, et Preset de son “0” dans la liste Tap Non utilisé 4•4 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Fonction du FBV Shortboard MkII Modèle et paramètre pré-configuré du POD Farm 2 Stomp
Effets “pédales” (distorsions, dynamique, filtres) - On/Off Modulation Modulations - On/Off Delay Délais - On/Off Reverb Réverbérations - On/Off Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Pédale 2 Pas d’affectation Fonction du FBV
Shortboard MkII Paramètre global pré-configuré du POD Farm 2 (POD Farm 2 en version autonome uniquement) Fonction 1 Son A/B - sélectionne le son Tone A ou Tone B Fonction 2 Accordeur - affiche ou non l’accordeur Tap Tap Tempo - détermine le tempo global Pédale de volume Niveau de
mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Shortboard.fbv • Contacteurs Bank Up & Bank Down - Ces deux contacteurs sélectionnent le Preset de son dans la liste sélectionnée. • Contacteurs A, B, C & D - Ces
contacteurs sélectionnent la liste de Presets indiquée ci-dessus. Le premier Preset de la liste est alors automatiquement chargé (celui avec un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied Bank Up & Down pour sélectionner les Presets de sons dans la liste sélectionnée.
Notez que par défaut, POD Farm 2 ne possède aucune liste de Presets : les contacteurs au pied Bank Up & Down et A, B, C & D ne font rien tant que vous ne créez pas un maximum de 4 listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en
savoir plus sur la création et la gestion des listes (accessible par la touche d’aide de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteurs d’effets et pédale Wah - Déclenchent les fonctions listées ci-avant dans les Presets de sons “POD Farm 2” : seuls ces Presets POD Farm 2
disposent d’assignations MIDI “locales”. Notez que certains Presets de sons ne possèdent pas toutes ces affectations et ces effets - la plupart des Presets de sons ne contiennent que quelques effets et affectations MIDI. • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection
On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pédale 2
- Ce contrôleur n’accède à aucune affectation pré-configurée. Mais, étant donné que le Preset FBV règle la Pédale 2 pour qu’elle transmette un message de CC MIDI, vous pouvez utiliser la fonction d’apprentissage MIDI de POD Farm 2 pour affecter ces fonctions du FBV à des paramètres de POD



Farm 2. • Contacteurs Function 1, Function 2 & Tap - Ces contrôleurs sont réglés sur des affectations MIDI “globales”, qui n’existent que sous la forme d’affectations MIDI dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales dans le Plug-In POD Farm 2 pour n’importe quel contrôleur de votre FBV MkII !). Voir les sections plus avant. 4•5 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Pédale de volume - Règle les Faders de niveau des sons A et B dans la
fenêtre de mixage. Si le POD Farm 2 utilise un seul son, c’est le son A. Ceci est une affectation MIDI globale. Pédalier FBV Express MkII Réglages du Preset POD Farm 2-Express.fbv, chargé dans l’application FBV Control Les réglages MIDI ci-dessus du FBV Express MkII contrôlent ainsi le POD Farm
2 : Fonction du FBV Express MkII Modèle et paramètre pré-configuré du POD Farm 2 A Sélectionne la liste précédente avec son premier Preset de son B Sélectionne la liste suivante avec son premier Preset de son C Charge le Preset de sons précédent dans la liste sélectionnée D Charge le Preset de
sons suivant dans la liste sélectionnée Contacteur de la pointe du pied Wahs - On/Off, effet Bender On/Off Pédale Wah Wahs - règle le bouton Position Contrôle du FBV Express Paramètre global pré-configuré du POD Farm 2 MkII (POD Farm 2 en version autonome uniquement) Pédale de volume
Niveau de mixage du son Tone A et du son Tone B Fonctions pré-configurées de POD Farm 2 gérables par le Preset de réglages POD Farm 2-Express.fbv • Contacteurs A & B - Sélectionnent la liste de Presets précédente/suivante. Le premier Preset de la liste est automatiquement chargé (celui avec
un “0” à sa gauche). Ceci vous permet d’utiliser alors les contacteurs au pied C & D pour sélectionner les Presets de sons dans la liste sélectionnée • Contacteurs C & D - Sélectionnent le Preset de son précédent et suivant dans la liste sélectionnée. Notez que par défaut, POD Farm 2 ne possède
aucune liste de Presets : les contacteurs au pied A, B, C & D ne font rien tant que vous ne créez pas de listes avec des Presets de sons Tone dans ces listes. Consultez le Guide de prise en main du POD Farm 2 pour en savoir plus sur la création et la gestion des listes (accessible par la touche d’aide
de POD Farm 2, ou sur le site de l’aide en ligne de POD Farm). • Contacteur de fin de course - Ce contacteur peut être assigné à la sélection On/Off d’un modèle de Wah, ou à la sélection On/Off d’un modèle de Bender dans certains Presets du répertoire source “POD Farm 2” . Ce contacteur possède
également une fonction “câblée” pour que la fonction “Pedal 1” du FBV Shortboard MkII sélectionne “Pedal Wah” ou “Pedal Volume”. • Pedal Wah - Règle le bouton “Position” des modèles de Wah dans les Presets de sons “POD Farm 2”. Dans certains Presets de sons, il est possible d’utiliser une pédale
pour contrôler le bouton de “Position” d’un modèle de Bender, et obtenir des effets de transposition super cools. • Pédale de volume - Règle les Faders de niveau des sons A et B dans la fenêtre de mixage. Si le POD Farm 2 utilise un seul son, alors seul le Fader du son A est contrôlé. Notez que ceci est
une 4•6 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 affectation MIDI globale et n’existe sous la forme d’une affections MIDI pré-configurée MIDI que dans l’application autonome POD Farm 2 et pas dans le Plug-In (ceci dit, vous pouvez utiliser la fonction d’apprentissage MIDI pour
créer manuellement des affectations MIDI globales avec votre pédalier FBV Express MkII !). Avec ces réglages effectués sur le pédalier, quittez FBV Control et configurez POD Farm 2. Application autonome POD Farm 2 - Configuration des entrées MIDI Pour utiliser votre pédalier avec l’application
autonome POD Farm 2, vous devez configurer POD Farm 2 en réception des données transmises par les des ports MIDI de votre pédalier FBV MkII. Si vous souhaitez contrôler le Plug-In POD Farm 2, consultez la section «Plug-In POD Farm 2 - Configuration des entrées MIDI» en page 4•8. La gestion
MIDI du Plug-In POD Farm 2 necessite la configuration des réglages MIDI dans l’application audionumérique hôte. • Lancez le menu Preferences de POD Farm 2 et cliquez sur l’onglet MIDI. Vous pouvez alors sélectionner n’importe quel contrôleur ou port MIDI connecté. Notez que les 4 ports MIDI de
votre FBV s’affichent différemment, selon le système d’exploitation de l’ordinateur : Préférences - menu MIDI dans Mac OS® X Préférences - menu MIDI dans Windows® 7 et Windows Vista® Préférences - menu MIDI dans Windows® XP 4•7 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm
2 • Par défaut vous voyez tous les ports de tous les périphériques MIDI Line déjà sélectionnés. Gardez uniquement ceux que vous souhaitez utiliser pour le contrôle de POD Farm 2. Vos réglages seront mémorisés à l’avenir. • Dans notre exemple, vous pouvez voir que nous avons choisi de recevoir les
données MIDI uniquement du Port 1 du pédalier Line 6 FBV Shortboard MkII connecté (notez que notre processeur Line 6 UX2 est également une option, étant donné que la connexion de ses contacteurs au pied 1 & 2 peut être configurée pour transmettre aussi les données MIDI, mais pour cet
exemple, nous n’utiliserons que le Port 1 du FBV MkII). • Cliquez sur OK pour quitter les préférences du POD Farm 2 et achever la configuration des entrées MIDI. Vous êtes prêt à utiliser le FBV MkII avec POD Farm 2 ! Lisez la page “Take Control” en page 4•6. Plug-In POD Farm 2 - Configuration des
entrées MIDI Le Plug-In POD Farm 2, comme tous les Plug-Ins d’effets audio, est utilisé dans les pistes audio d’une application hôte. Le Plug-In POD Farm 2 peut recevoir les données MIDI des ports USB MIDI de votre pédalier FBV MkII, ce qui permet la gestion par MIDI de ses paramètres. Ceci dit, il
est nécessaire de router les communications MIDI par votre logiciel hôte pour accéder au Plug-In POD Farm 2. Cette configuration peut être légèrement différente selon l’application audionumérique hôte, et il est conseillé de consulter la documentation de l’application hôte. Le processus implique que
vous choisissiez de recevoir les données MIDI des ports MIDI du FBV MkII dans l’application hôte. Vous devez ensuite sélectionner l’entrée MIDI In à l’une des pistes MIDI de l’application hôte et la sortie Out à la piste audio où le Plug-In POD Farm 2 est inséré. Pour continuer, nous avons ajouté un
tutoriel rapide du célèbre logiciel audionumérique Ableton Live®, configuré pour être utilisé avec un pédalier FBV MkII qui contrôle les paramètres du Plug-In POD Farm 2. Les étapes sont identiques avec les autres applications. ASTUCE : Pour les tutoriels sur la configuration d’un contrôleur MIDI
externe du Plug-In POD Farm 2 avec plusieurs applications hôte célèbres, consultez le Guide de prise en main du POD Farm 2, disponible en téléchargement sur le site de l’aide en ligne de POD Farm ! Avec le pédalier FBV MkII connecté à l’ordinateur, lancez Ableton Live, et allez dans : • Mac® - menu
Ableton Live > Préférences > MIDI/Sync page • Windows® - menu Options > Préférences > MIDI/Sync page Ableton Live détecte automatiquement vos ports de sortie MIDI FBV MkII. Il se peut que vous voyez d’autres ports de périphériques MIDI, selon les équipements MIDI installés ou connectés à
l’ordinateur. 4•8 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Sélectionnez le port de sortie FBV MIDI Out ici (chaque port FBV peut être sélectionné pour un maximum de Passez les boutons 4 entrées MIDI, si “Track” et vous le souhaitez) “Remote” sur “On” pour votre port* d’entrée
MIDI Ableton Live - Sélection du FBV MkII en entrée MIDI (Mac OS® X) *Il n’est nécessaire d’activer l’option MIDI In “Remote” que pour permettre à Live de recevoir les données de contrôleur MIDI depuis le port MIDI sélectionné. Ceci dit, pour permettre à Live de recevoir les données MIDI sur une piste
MIDI, vous devez activez l’option de piste “Track” - vous aurez besoin d’une entrée de piste MIDI pour router les données de contrôle MIDI au Plug-In POD Farm 2. Notez que lorsque vous sélectionnez les ports FBV MkII MIDI dans l’application hôte, les noms de ports USB MIDI sont différents sur Mac®
OS X, Windows® Vista ou XP (pour le FBV Express MkII, “Express” s’affiche à la place de “Shortboard” dans les champs) : Mac OS® X Windows® 7 et Vista® Windows® XP Port MIDI Out 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II Périphérique audio USB Port MIDI Out 2 FBV Shortboard
Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II Périphérique audio USB [2] Port MIDI Out 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II Périphérique audio USB [3] Port MIDI Out 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV Shortboard Mk II Périphérique audio USB [4] Ensuite, insérez le
Plug-In POD Farm 2 sur l’une des pistes de l’application audio hôte, et configurez l’une des pistes MIDI de l’application hôte pour qu’elle reçoive les données MIDI du FBV et les affecte à la piste audio et au Plug-In POD Farm 2. Par exemple, voici comment configurer Ableton Live, avec le Plug-In POD
Farm 2 inséré sur la piste Audio 1 : Armez la piste MIDI pour Le Plug-In POD Farm 2 est activer la transmission MIDI inséré sur la piste Audio 1 Sur une nouvelle piste MIDI, réglez l’entrée pour qu’elle reçoive sur le port MIDI FBV MkII sur lequel les commandes sont transmises Réglez la sortie sur la
piste audio où le Plug-In POD Farm 2 est inséré Le Plug-In POD Farm 2 apparaît comme la destination de canal de sortie MIDI Configuration d’Ableton Live avec l’entrée MIDI FBV MkII affectée au Plug-In POD Farm 2 4•9 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 Une fois ces
affectations MIDI achevées, vous pouvez utiliser le pédalier FBV MkII avec le Plug-In POD Farm 2 ! Fenêtre des affectations MIDI de POD Farm 2 La fenêtre MIDI Assignments View affiche toutes les affectations MIDI du Preset de son courant dans POD Farm 2 en version Plug-In ou autonome. Comme
nous l’avons vu en page 4•3, si vous avez chargé les Presets “POD Farm 2” FBV Control dans votre pédalier FBV MkII, vous pouvez alors accéder aux affectations MIDI “pré-configurées” des Presets de son de POD Farm 2. Utilisez la fenêtre des affectations MIDI pour visualiser ou éditer les réglages
MIDI. Utilisez les touches X pour effacer les affectations MIDI existantes. Touche d’affectation MIDI Affectation d’automation Touche de suppression globale Suppression Affectation MIDI “locale” Affectation MIDI “globale” (en jaune) (en blanc) Fenêtre des affectations MIDI de POD Farm 2 Affectations
MIDI locales et globales Notez que les affectations MIDI “locales” sont spécifiques au Preset de son courant de POD Farm 2 (et sauvegardées avec le Preset). Les Presets de sons du répertoire source “POD Farm 2” possèdent des affectations MIDI locales. Les affectations MIDI “globales” restent dans
POD Farm 2 (version autonome ou Plug-In), même lorsque vous changez de Preset. L’application POD Farm 2 en version autonome regroupe certaines affectations MIDI globales pré-configurées. Les affectations MIDI locales et globales peuvent être créées manuellement avec le pédalier FBV MkII et la
fonction d’apprentissage de POD Farm (fonction MIDI Learn, abordée dans la section suivante). Pour obtenir de plus amples détails sur la fenêtre d’affichage des affectations MIDI, consultez le Guide de prise en main du POD Farm 2. Fonction d’apprentissage MIDI Learn de POD Farm 2 La fonction
MIDI Learn de POD Farm 2 vous permet facilement d’affecter les contacteurs et pédales du pédalier FBV MkII aux paramètres de POD Farm 2. Vous pouvez utiliser la fonction MIDI Learn pour “personnaliser” n’importe quel Preset de son de POD Farm 2 et ajouter des affectations MIDI du pédalier FBV
MkII. Les étapes d’utilisation de la fonction MIDI Learn sont simples : • Dans POD Farm 2 (en version autonome ou Plug-In), chargez un Preset de son, ou configurez un son avec les modèles souhaités. • Double-cliquez sur n’importe quel modèle dans la fenêtre du trajet du signal pour charger la fenêtre
d’édition. 4•10 Mode d’emploi détaillé du FBV MkII : Contrôle de POD Farm 2 • Dans la zone d’édition Edit, cliquez avec le bouton droit de la souris (Windows®) ou utilisez la touche Ctrl en cliquant (Mac®) directement sur le bouton, sélecteur ou curseur du modèle que vous souhaitez commander, et
sélectionnez le menu MIDI Control. • Dans le sous-menu MIDI Control, cliquez sur MIDI Learn. Le POD Farm 2 passe en mode d’apprentissage automatique MIDI Learn, et attend de recevoir une commande du contrôleur MIDI connecté. • Appuyez sur le contacteur ou sur la pédale du FBV que vous
souhaitez utiliser pour contrôler le paramètre sélectionné : le contacteur ou la pédale du FBV sont automatiquement “mémorisés” par POD Farm 2. Tous les paramètres de POD Farm 2 avec la fonction MIDI Learn peuvent “apprendre” automatiquement n’importe quelle commande de Contrôleur Continu
MIDI (CC MIDI), de Note On ou de molette de hauteur. Par conséquent, si vous créez des réglages de commande MIDI dans l’application FBV Control, ces commandes sont celles que vous devez configurer pour que les contrôleurs du pédalier FBV MkII gèrent les paramètres de POD Farm 2. Notez
également que la plupart des fonctions “On/Off” de POD Farm 2 nécessitent que vous configuriez les CC MIDI en mode de bascule “Toggle” (état On ou Off) ou en mode temporaire “Momentary” (pour basculer le paramètre sur “On” uniquement lorsque vous appuyez sur le contacteur). Notez également
que la plupart des applications audionumériques offrent une fonction d’apprentissage MIDI automatique, séparée de celle de POD Farm 2. Avec les applications audionumériques qui permettent la gestion par MIDI, il est en général possible d’utiliser votre pédalier FBV MkII pour contrôler les paramètres
de pistes et de mixage, ainsi que les paramètres du Plug-In POD Farm 2 et d’autres Plug-Ins dans les options de l’application audionumérique. Ces fonctions sont abordées dans le chapitre «FBV™ MkII et applications logicielles» en page 6•1. Pour de plus amples renseignements sur le contrôle MIDI de
POD Farm 2, consultez les informations supplémentaires sur POD Farm 2, sur le site l’aide en ligne de POD Farm. 4•11 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox FBV™ MkII avec Line 6 GearBox™ Ce chapitre a été créé pour utiliser votre pédalier Line 6 FBV
Shortboard™ MkII ou FBV Express™ MkII avec l’application Line 6 GearBox. Allons-y... Qu’est-ce que GearBox ? Au cas où vous vous demanderiez... Line 6 GearBox est l’application gratuite pour les utilisateurs des interfaces audio USB Line 6 (processeurs* POD Studio™, TonePort™, GuitarPort™*).
GearBox est équipé d’une interface utilisateur complexe qui vous permet d’accéder à tous les amplis guitare et basse, aux préamplis, aux enceintes, aux micros, et aux effets Line 6. Cette interface audio USB Line 6, vous permet de bénéficier des sons légendaires du POD sur votre ordinateur, et vous
pouvez les utiliser en enregistrement dans votre application audio, accompagner vos morceaux préférés, ou souscrire au service en ligne de GuitarPort Online ! *Remarque : GearBox peut également utiliser un POD®xt ou un POD® X3 comme interface audio par la liaison USB. Ceci dit, il est conseillé de
connecter votre FBV MkII à ces processeurs POD® directement avec le câble RJ-45, plutôt que de relier le pédalierFBV via USB à l’ordinateur. Lorsque vous contrôlez votre POD directement avec votre FBV MkII, les contrôles de GearBox répondent aussi ! Pour obtenir GearBox, connectez votre
interface USB audio Line 6 à votre ordinateur Mac® ou Windows®, lancez Line 6 Monkey et laissez le petit singe faire le boulot ! Ou allez directement à la page et téléchargez-le. Si ce n’est pas encore fait, téléchargez et installez le logiciel Line 6 FBV Control. Vous en aurez besoin pour charger et éditer
les informations de gestion MIDI de votre pédalier FBV pour qu’il communique avec GearBox. Consultez la page «L’application Line 6 FBV Control» en page 3•1 pour obtenir les instructions de téléchargement. Connectez-vous Pour faire tourner GearBox, vous devez connecter votre interface USB audio
Line 6 à votre ordinateur, et connecter votre pédalier FBV MkII à un autre port USB. Une fois connecté, procédez comme suit afin de recevoir les données de contrôle MIDI du pédalier FBV MkII. • Lancez GearBox dans Applications > Line 6 > GearBox (Mac®), ou Démarrer > Programmes > Line 6 >
GearBox (Windows®) • Dans GearBox, allez dans GearBox > Preferences > MIDI/Control (Mac®), ou Edit > Preferences > MIDI/Control (Windows®). • Dans les réglages MIDI, sélectionnez l’option “Send MIDI...” et sélectionnez le premier port disponible pour votre pédalier FBV MkII.* Désélectionnez
l’option “Send MIDI...” Sélectionnez le premier Port de votre pédalier FBV MkII • Cliquez sur OK pour quitter la fenêtre. 5•1 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox * Notez que le nom des ports de sorties MIDI Out du pédalier FBV MkII apparaît différemment selon le
système d’exploitation de l’ordinateur (avec le FBV Express MkII, “Express” remplace “Shortboard”) : Mac OS® X Windows Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio USB (Port 1) MIDI Out Port 2 FBV Shortboard Mk II MIDIIN2 FBV Shortboard
Mk II P. Audio USB [2] (Port 2) MIDI Out Port 3 FBV Shortboard Mk II MIDIIN3 FBV Shortboard Mk II P. Audio USB [3] (Port 3) MIDI Out Port 4 FBV Shortboard Mk II MIDIIN4 FBV Shortboard Mk II P. Audio USB [4] (Port 4) MIDI In Port 1 FBV Shortboard Mk II FBV Shortboard Mk II Périphérique Audio
USB (Port 1) Ceci termine la configuration nécessaire pour GearBox. Nous devons ensuite configurer le FBV MkII pour qu’il transmette les commandes MIDI spécifiques pour déclencher les fonctions souhaitées de GearBox. La façon la plus simple consiste à sélectionner le Preset GearBox.fbv FBV
fourni avec l’application Line 6 FBV Control. • Lancez Line 6 FBV Control dans Applications > Line 6 > Line 6 FBV Control (Mac®), ou Start > Programs > Line 6 > Line 6 FBV Control (Windows®) • Allez dans File > Open et sélectionnez le Preset GearBox.fbv : • Documents > Line 6 > FBV > Presets
(Mac®) • Mes Documents > Line 6 > FBV > Presets (Windows®) Ceci charge automatiquement toutes les affectations des commandes de GearBox MIDI dans la mémoire interne de votre pédalier FBV MkII. La liste Control Properties affiche les réglages : Réglages du Preset GearBox.fbv chargés dans
un FBV Shortboard MkII 5•2 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Réglages du Preset GearBox.fbv chargés dans un FBV Express MkII Pour référence, ce tableau indique la commande affectée à chaque contacteur au pied du pédalier FBV pour contrôler
GearBox (fichier de Preset GearBox.fbv) : FBV Shortboard MkII Pédalier FBV Fonction de GearBox FUNC 1 Effet Comp On/Off FUNC 2 Amp/Preamp On/Off BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D Pas
d’affectation TAP Tap Tempo STOMP Effet Stomp On/Off MODULATION Effet Modulation On/Off DELAY Effet Delay On/Off REVERB Effet Reverb On/Off CONTACT. POINTE DE PIED* Effet Wah On/Off PÉDALE WAH Position Wah PÉDALE VOL Position Volume PÉDALE 2 Delay Mix Level * Le
contacteur de pointe de pied permet de passer de la pédale de volume à la pédale de Wah et inversement. FBV Express MkII Pédalier FBV Fonction de GearBox BANQUE SUP. Lecteur - Play/Stop BANQUE INF. Lecteur Transport - Rewind A Effet Gate On/Off B Effet EQ On/Off C Pas d’affectation D
Pas d’affectation CONTACT. POINTE DE PIED* Effet Wah On/Off 5•3 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Pédalier FBV Fonction de GearBox PEDAL WAH Position Wah PEDAL VOL Position Volume * Le contacteur de pointe de pied permet de passer de la
pédale de volume à la pédale de Wah et inversement. Avec ces réglages vous devriez être prêt. Essayez les contacteurs et pédales du FBV et GearBox devrait répondre ! Personnalisez les contrôles de GearBox Ces réglages sont super, mais vous souhaitez encore plus de contrôle, dites-vous ? Pas de
problème ! Certaines fonctions de GearBox peuvent être commandées à distance, par messages MIDI. Tout ce que vous avez à faire, c’est d’éditer les réglages à l’intérieur du logiciel Line 6 FBV Control, en saisissant les affectations de commandes MIDI correspondant aux fonctions de GearBox. Pour
commencer, vous devez savoir quelle commande MIDI fait quoi dans. Ces informations sont disponibles dans le document Line 6 MIDI CC Reference, disponible en téléchargement sur le site FBV MkII Online Help. Prenez le temps de consulter la section GearBox MIDI CC Reference Chart pour obtenir
la liste des fonctions de GearBox avec leurs n° de CC MIDI et les valeurs correspondantes. Consultez également le document GearBox Model Tables pour obtenir la liste des Messages de CC MIDI d’affectation des modèles d’amplis et d’effets. Configurez la pédale du FBV pour contrôler un bouton de
GearBox Il y a également beaucoup de boutons dans GearBox, et vous pouvez configurer la pédale de votre FBV MkII (ainsi que la pédale d’expression optionnelle du Shortboard) pour contrôler n’importe quel bouton de GearBox ! Par exemple, si vous souhaitez que la pédale WAH du FBV contrôle le
paramètre Modulation Mix de GearBox plutôt que la position de Wah. En consultant le tableau des CC MIDI de GearBox, le paramètre Modulation Mix est le CC n° 56, avec des valeurs Min. et Max. de 0 à 127: Ceci vous indique que vous devez créer ces réglages dans l’application Line 6 FBV Control
dans la rangée “PEDAL WAH” de la liste Control Properties: • MIDI Command : MIDI CC • Value : CC# 056 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel
: 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). 5•4 Mode d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox La page des valeurs Min. et Max. du tableau de référence des CC MIDI vous indique que ce paramètre est contrôlable de 0 à 100 % (l’équivalent de 0 à
127 en termes de valeurs de CC MIDI). Par conséquent, vous n’avez pas besoin de faire quoi que ce soit d’autre pour que la pédale contrôle le paramètre Modulation Mix. Vous pouvez configurer la pédale du FBV pour gérer n’importe quel autre paramètre que vous voyez dans le tableau de référence
MIDI de GearBox. ASTUCE : Vous souhaitez contrôler le bouton Bender Position de GearBox avec la pédale, pour faire des Pitch Bend de fou ? Dans Line 6 FBV Control, Control Properties, réglez la pédale sur “MIDI CC” pour le paramètre MIDI Command, avec le “CC 79” comme valeur. Dans
GearBox, réglez le bouton Mix de l’effet Bender sur 100 % pour entendre uniquement le signal transposé, et réglez les boutons Heel et Toe sur les valeurs de transposition souhaitées (en demi-tons), et jetez-vous en l’air ! Configurer un contacteur au pied pour activer/désactiver l’effet de votre ampli Le
Preset GearBox.fbv configure les amplis et effets de GearBox amp pour être activés/désactivés au pied, mais si vous souhaitez modifier l’affectation d’un contacteur, vous pouvez consulter le PDF de référence des CC MIDI Line 6, et jetez un œil au tableau des CC MIDI de GearBox. Regardez le
paramètre d’effet de GearBox qui vous intéresse et notez son n° de CC. Par exemple, si vous souhaitez que le contacteur “C” du FBV active/désactive le délai de GearBox, vous pouvez voir dans le tableau de référence des CC MIDI de GearBox, que c’est le CC n° 28 qui vous intéresse : Vous pouvez
également voir dans la zone Notes qu’une valeur de CC de 0-63 désactive le délai, et qu’une valeur de 64-127 active le délai. Mais vous n’avez pas besoin de configurer manuellement ces valeurs de CC, car le mode “Toggle” du FBV des contacteurs fait déjà cela pour vous automatiquement. De cette
façon, les messages MIDI transmis alternent entre “127 (“On”) et “0” (Off) pour chaque pression successive sur le contacteur au pied. Par conséquent, les réglages à saisir dans la liste Control Properties de FBV Control pour le contacteur C sont les suivants : • MIDI Command : MIDI CC • Value : CC#
028 • MIDI Port : 1 (vous pouvez aussi sélectionner n’importe quel port disponible ici, mais les réglages MIDI In de GearBox doivent correspondre. Voir «Connectez-vous» en page 5•1). • MIDI Channel : 1 (GearBox reçoit les données MIDI sur la canal 1 uniquement). • Switch Mode : Toggle 5•5 Mode
d’emploi détaillé des pédaliers FBV MkII — Contrôle de Line 6 GearBox Configurer un contacteur au pied pour gérer le lecteur de GearBox Le module de lecture Player de GearBox vous permet de charger et de lire des fichiers audio à partir d’un CD ou du disque dur de votre ordinateur, ou pour lire les
leçons et les pistes en ligne de GuitarPort Online. Si vous souhaitez laisser vos mains sur le manche de votre guitare, pendant que vous utilisez le lecteur, vous pouvez assigner n’importe quel contacteur du FBV au contrôle des fonctions de transport Rewind, Play, Stop ou Fast Forward. Pour cela,
réglez la commande MIDI Command sur “Mackie” et puis sélectionnez la fonction souhaitée, comme indiqué ci-dessous : OK, vous devriez maintenant savoir comment utiliser votre pédalier FBV avec GearBox, alors arrêtez de jouer avec votre ordinateur et concentrez-vous sur la musique ! 5•6 Mode
d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles FBV™ MkII et applications logicielles Une fois les connexions réalisées (vous pouvez toujours revenir au chapitre «Mise en œuvre» en page 1•1), vous devriez être prêt à utiliser votre pédalier FBV Shortboard™ MkII ou FBV
Express™ MkII pour contrôler votre application logicielle préférée ! Voici quelques astuces sur la configuration d’autres applications logicielles pour communiquer avec votre pédalier FBV MkII. À propos des ports et canaux USB MIDI Une fois connecté à un port USB de votre ordinateur Mac® ou
Windows®, le pédalier FBV MkII établit un port USB “MIDI In” et quatre ports USB “MIDI Out” sur votre ordinateur*. Ces ports ne sont pas des ports “physiques” nécessitant des câbles MIDI partout — le pédalier FBV communique ses données MIDI par le câble USB à ces ports MIDI “virtuels”. Le port
FBV MIDI In est utilisé par votre pédalier FBV MkII pour recevoir les données MIDI, et sa fonction principale est de permettre au FBV de communiquer avec les applications Line 6 Monkey et FBV Control. Il y a peu de chances pour vous utilisiez ce port MIDI In avec d’autres logiciels, étant donné que le
FBV transmet les ordres MIDI par ses ports de sorties MIDI Out. Vous pourrez accéder à ces ports MIDI FBV dans les Options ou les Préférences de n’importe quel logiciel de votre ordinateur compatible avec les communications MIDI. Communication des ports MIDI sous Windows® Il est important de
noter que le pilote universel USB Windows® qui est utilisé pour votre pédalier FBV MkII sous Windows® 7, Windows Vista® et Windows® XP, ne permet pas à plus d’une application à la fois d’utiliser plusieurs ports USB MIDI en même temps. Le logiciel FBV Control, lorsqu’il démarre, utilise le port FBV
MIDI In et le port MIDI Out 4 pour communiquer avec votre pédalier FBV. Par conséquent, si vous avez d’autres logiciels MIDI/audionumériques tournant en même temps sur votre ordinateur Windows® configurés pour utiliser les mêmes ports FBV MIDI, une seule application est autorisée à
communiquer. Si votre application MIDI/audionumérique tourne déjà, et si le port FBV MIDI In est activé, le fait de lancer l’application FBV Control cause une erreur de détection du pédalier FBV connecté, car il est déjà “utilisé” par une autre application. Il est possible de désactiver l’utilisation du port FBV
MIDI In et du port FBV MIDI Out 4 dans votre application MIDI/audionumérique pour pouvoir aussi utiliser l’application FBV Control (vous devriez pouvoir toujours utiliser les ports FBV MIDI Out 1 à 3, pour commander votre application MIDI/audionumérique à partir de votre pédalier FBV). Sinon, quittez
toutes les applications MIDI/audionumériques lorsque vous utilisez le logiciel FBV Control et libérez les ports MIDI pour son fonctionnement. Remarque : L’application Line 6 Monkey utilise également les ports FBV MIDI pour détecter et mettre à jour votre pédalier FBV. Il est toujours recommandé de
quitter FBV Control, et toute application MIDI/ audionumérique avant de lancer Line 6 Monkey. Configurer votre logiciel pour les communications du port MIDI du FBV MkII La plupart des applications MIDI et audionumériques offrent ces options dans leur menu “Preferences” ou “MIDI Options”, où vous
devrez sélectionner votre pédalier FBV MkII et/ou le port MIDI USB FBV pour permettre à l’application de recevoir les commandes du FBV. Ces options peuvent être présentées différemment dans votre logiciel MIDI/audionumérique... 6•1 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Options de surface de contrôle Certaines applications offrent un sélecteur pour choisir une ou plusieurs “Surface de contrôle” ou “Contrôleur MIDI” : commencez par vérifier si votre application offre cette option. Vous devriez voir 4 options pour le pédalier FBV MkII connecté : une
pour chaque port MIDI Out. Notez les différences de gestion des ports MIDI Out du FBV MkII selon le système d’exploitation utilisé (pour le FBV Express MkII, “Express” remplace “Shortboard”): Mac OS® X Windows® 7 et Vista® Windows® XP MIDI Out Port 1 FBV Shortboard Mk II (Port 1) FBV
Shortboard Mk II USB Audio Device MIDI Out Port 2 FBV Shortboard Mk II (Port 2) MIDIIN2 FBV Shortboard Mk II USB Audio Device [2] MIDI Out Port 3 FBV Shortboard Mk II (Port 3) MIDIIN3 FBV Shortboard Mk II USB Audio Device [3] MIDI Out Port 4 FBV Shortboard Mk II (Port 4) MIDIIN4 FBV
Shortboard Mk II USB Audio Device [4] MIDI In Port 1 FBV Shortboard Mk II (Port 1) FBV Shortboard Mk II USB Audio Device ASTUCE : Consultez le chapitre «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4 pour voir comment le FBV MkII apparaît dans la liste Preferences
des contrôleurs MIDI de Live. Sélectionnez le port FBV MIDI Out sur lequel vous avez assigné les contrôleurs du FBV dans la liste Control Properties du logiciel Line 6 FBV Control. Par défaut, toutes les affectations des contrôles du FBV MkII sont configurées pour transmettre par le port FBV MIDI Out 1,
mais vous pouvez changez le port MIDI Out dans le logiciel Line 6 FBV Control (liste Control Properties en page 3•2). Remarque : Vous n’avez pas besoin de sélectionner le port FBV MIDI In depuis votre logiciel MIDI/ audionumérique car vous n’avez pas à transmettre de données MIDI entre le logiciel et
le pédalier FBV (les applications Line 6 FBV Control et Monkey utilisent le port MIDI In du FBV pour les communications, mais aucun réglage n’est nécessaire pour ça). Dans de nombreux cas, c’est tout ce que vous avez à faire, et le logiciel MIDI/audionumérique reçoit vos commandes MIDI. Certaines
applications, ceci dit, offrent des options supplémentaires pour sélectionner la marque ou le type de contrôleur MIDI pour communiquer correctement avec lui. Pour les autres applications, sélectionnez un contrôleur “générique”. De plus, certaines applications vous permettent également de modifier le
nom de ports MIDI de votre contrôleur, avec des noms personnalisés. Consultez le manuel de votre logiciel MIDI. Vous pouvez également consulter les exemples suivants sur plusieurs logiciels MIDI populaires. Options d’entrées MIDI Dans certaines applications MIDI et audionumériques, le menu
Preferences ou MIDI Options affiche uniquement les réglages d’entrées “MIDI Input” (à la place d’un menu spécifique “Control Surface” ou “MIDI Control”, comme nous l’avons vu). Si le mode d’emploi de votre logiciel MIDI/audionumérique vous demande d’utiliser ce menu pour sélectionner les
contrôleurs MIDI, sélectionnez le port MIDI FBV que vous avez assigné aux contrôleurs de votre pédalier FBV dans la liste Control Properties de l’application Line 6 FBV Control. Par défaut, toutes les données en provenance du FBV MkII sont transmises par le port MIDI Out 1 du FBV, mais vous pouvez
changer ce port MIDI Out à l’intérieur de la liste Control Properties du logiciel Line 6 FBV Control (voir page 3•2). 6•2 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Canaux MIDI Chaque port USB MIDI porte 16 canaux MIDI. Les canaux MIDI sont comme des
chaînes de télévision — votre TV peut recevoir plusieurs chaînes, mais vous devez sélectionner une chaîne si vous souhaitez la regarder. Il en est de même avec le MIDI. Par défaut, votre pédalier FBV MkII transmet les données MIDI sur le canal 1 du port MIDI sélectionné pour chaque contrôle. Ceci
dit, vous pouvez régler chaque contrôle du pédalier FBV pour transmettre ses données de gestion MIDI sur n’importe quel canal MIDI (consultez la en page 3•2). Il se peut que votre logiciel vous offre des options de réception uniquement sur un canal MIDI spécifique sur le port MIDI sélectionné. Ceci
vous permet de régler votre pédalier FBV MkII pour qu’il transmette toutes les commandes MIDI sur un même port MIDI commun, tout en assignant certains messages à certains canaux spécifiques, ce qui permet à votre logiciel MIDI/audionumérique de “filtrer” et de recevoir uniquement les commandes
souhaitées. Consultez la documentation de votre logiciel pour obtenir les informations sur les options de canal MIDI. Fonction d’apprentissage MIDI automatique De nombreuses applications sont maintenant équipées d’une fonction d’apprentissage MIDI (“MIDI Learn”) : il vous suffit de cliquer sur le
bouton/curseur/touche dans l’interface utilisateur de l’application pour la placer dans un mode “d’apprentissage”. Il vous suffit ensuite d’accéder simplement au contrôleur sur votre pédalier FBV MkII pour que l’application fasse correspondre le contacteur/ pédale du pédalier FBV au paramètre sélectionné.
Par exemple, Propellerhead Reason et Ableton Live offrent ces fonctions pour la plupart de leurs paramètres, dont les touches de transport, les options de pistes, et même pour les synthés virtuels et les effets ! Pour les applications offrant cette fonction d’apprentissage MIDI, vérifiez que les pédales et
les contrôleurs du FBV MkII possèdent des commandes MIDI assignées que le logiciel puisse “apprendre”. Ce qui est sympa avec cette fonction d’apprentissage MIDI Learn, vous n’avez qu’à configurer le contrôleur pour qu’il transmette les messages de CC MIDI avec les valeurs souhaitées. Le logiciel
ne fait qu’écouter et apprendre les informations reçues. Les paramètres de certaines applications nécessitent également un réglage spécifique de type de commutation “Switch Type” (Single, Toggle ou Momentary). Lisez le mode d’emploi du logiciel MIDI/audionumérique sur la fonction d’apprentissage
MIDI. Consultez les divers exemples qui suivent sur plusieurs applications audionumériques ! Réglez les contrôleurs du pédalier FBV MkII pour qu’il transmettent tous un message de CC MIDI différent. Pour configurer ces réglages, utilisez les options de la liste “Control Properties” (voir page 3•2), ou
chargez le Preset “FBV-Default.fbv” fourni et personnalisez-le. Affectation manuelle des contrôleurs MIDI Pour les applications qui n’offrent pas de fonction d’apprentissage MIDI, le processus devient plus manuel, et vous avez besoin de vous procurer les informations détaillées sur le fonctionnement du
MIDI auprès du fabricant du logiciel. Vous saurez ainsi quelles sont les commandes et valeurs MIDI déjà affectées aux différents paramètres dans le logiciel. La plupart du temps, les applications audionumériques utilisent des commandes de CC MIDI pour la gestion de leurs paramètres, des Program
Change pour les changements de Presets, et parfois des messages MMC ou Mackie pour les fonctions de transport. Avec la documentation de référence MIDI du fabricant en main, vous pouvez utiliser le logiciel FBV Control pour affecter les contrôleurs de votre pédalier FBV à la gestion des paramètres
MIDI correspondant dans l’application. Consultez la documentation de votre logiciel MIDI/audionumérique pour de plus amples détails sur la gestion des données MIDI. 6•3 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Ableton Live - Tutoriel de configuration du
pédalier FBV MkII Voici un tutoriel pas-à-pas sur la configuration de d’Ableton Live contrôlé par un pédalier FBV Shortboard ou Express MkII pour plusieurs fonctions. Dans cet exemple, nous utilisons Ableton Live version 8.02, mais les étapes sont identiques avec les versions plus récentes d’Ableton
Live (y compris la Version Live Lite de Line 6 que vous avez pu recevoir avec votre processeur Line 6 !). Ableton offre également une version de démonstration gratuite téléchargeable de Live sur www.ableton.com/ downloads. Ce tutoriel vous aide à comprendre les bases que vous pouvez appliquer à
d’autres logiciels MIDI/audionumériques. Ceci dit, les applications varient dans la gestion des informations MIDI. Consultez le mode d’emploi de votre logiciel ! Remarque : Dans cet exemple, nous utilisons un Mac®, mais les étapes sont les mêmes si vous utilisez Windows® XP, Windows® 7 ou Vista®
(sauf avis contraire). Configuration des contrôleurs du FBV La première étape, avant même de lancer Ableton Live, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Ableton Live, comme de nombreuses autres applications audionumériques, utilise les messages de
CC MIDI pour contrôler ses paramètres. Par conséquent, nous allons assigner les commandes de CC MIDI à notre contacteur et à notre pédale FBV avec le logiciel Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez
Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”. • Allez dans File > Save As et appelez le nouveau Preset “Live.fbv”. Ableton Live possède une fonction d’apprentissage “MIDI Learn” pour la configuration des contrôleurs MIDI (voir «Fonction d’apprentissage MIDI
automatique» en page 6•3 pour de plus amples détails). Cela signifie que peu importe la valeur de CC MIDI assigné à chaque contrôleur, dans la mesure où chaque contrôleur transmet une valeur de CC MIDI unique. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous
pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Assignez les contacts A, B, C & D aux CC MIDI CC 001 à 004. • Réglez le Switch Mode des contacts A, B, C & D sur “Single”, car nous voulons que chaque pression sur le contact transmette le même message de CC MIDI
à chaque fois. • Assignez les contrôleurs de pédale Wah et Vol aux CC MIDI 5 et 6. • Réglez le Port et le canal sur “1”, pour transmettre toutes nos données MIDI au port de sortie FBV USB MIDI Out 1, canal 1. • Laissons les autres contrôleurs du FBV sans affectation (Unassigned). 6•4 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à cela dans la liste Control Properties : Une fois les réglages créés allez dans File > Save pour sauvegarder le Preset, et quittez FBV Control. Configuration du périphérique d’entrée MIDI d’Ableton Live
Ensuite, nous devons configurer Ableton Live pour qu’il reçoive les commandes MIDI du FBV... Lancez Ableton Live, et allez dans Ableton Live > Preferences > MIDI/Sync page (Mac®) ou dans Options > Preferences > MIDI/Sync page (Windows®). Vous pouvez voir que Live détecte automatiquement
les quatre ports de sortie MIDI Out du FBV. Il se peut que vous voyiez également les autres périphériques MIDI installés sur votre ordinateur. Notez que ces noms de ports sont différents sous Mac OS® X, Windows® XP, Windows® 7 ou Windows Vista®, selon le cas. • Cliquez sur Remote à droite du
premier port FBV MIDI Out pour le placer sur “On”, et dé- sélectionnez tout autre bouton “On” des colonnes Track, Sync et Remote, comme indiqué ci- dessous. Ceci permet à Live de recevoir les commandes MIDI de port MIDI 1 de votre pédalier FBV. Les 4 ports MIDI Out Activez le premier port du FBV
sont indiqués FBV, et placez tout le comme entrées “Inputs” reste sur OFF disponibles dans Live Mac OS® X 6•5 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Il en va de même dans Windows® XP, Windows® 7 et Windows Vista®, mais un peu différemment.
Windows® XP Windows® 7 et Windows Vista® • Allez dans le menu Input dans la rangée supérieure de la fenêtre et sélectionnez le même périphérique FBV Port 1. Ceci permet à Live d’utiliser votre pédalier FBV comme périphérique d’entrée de contrôle MIDI. Une fois de plus, les noms de ports FBV
sont listés différemment que vous soyez sous Mac® ou sous Windows®, alors choisissez le premier port USB MIDI FBV de la liste : Sélectionnez le premier port FBV dans le menu Input. Laissez les autres menus Control Surface, Input et Output sur “None” pour que Live reçoive uniquement les données
MIDI du FBV • Fermez la fenêtre Preferences - ceci termine la configuration des entrées MIDI. Assignation des contrôleurs du FBV Nous devons “assigner” les contrôleurs du FBV aux fonctions de Live. Live appelle ce processus “Manual Mapping”, et nous devons placer Live en mode “MIDI Map”
(certaines applications l’appelle “MIDI Learn”). • Pour placer Live en mode MIDI Map, cliquez sur le bouton MIDI en haut à droite de l’écran de Live : • Certains contrôles de Live sont mis en évidence (en bleu, ici), comme sur notre capture d’écran (il se peut que votre version de Live soit différente). Ces
réglages mis en évidence peuvent être commandés à distance par MIDI. 6•6 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Pour assigner le réglage mis en évidence dans Live, cliquez dessus. Live attend de recevoir un message MIDI. Pour cette étape, nous
allons affecter les touches Play, Stop et Record de Live aux contacteurs A, B & C du FBV... En haut de la fenêtre de Live, cliquez sur la touche Play Un texte en bas de Live indique qu’il attend le message du contrôleur MIDI Appuyez sur le contact A du FBV. Le texte indique que le message a été reçu et
la touche Play est maintenant affectée. Laissez le mode sur “Absolute” Vous pouvez également voir que la touche Play a maintenant un “1/1” pour indiquer qu’elle est affectée au canal MIDI 1, CC n° 1, ce que nous avons saisi pour le contact “A” du FBV Pendant que vous êtes en mode d’assignation
MIDI, faites en de même pour les boutons Stop et Record, en leur assignant les contacts “B” et “C” du FBV. Les boutons de transport affichent les infos suivantes : 6•7 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Si la fenêtre MIDI Mappings est ouverte, vous
pouvez également voir vos assignations. Notez que si vous souhaitez les supprimer, sélectionnez l’assignation dans la liste et cliquez sur la touche Suppr du clavier de votre ordinateur. • Appuyez à nouveau sur le bouton de mode MIDI Map en haut à droite de la fenêtre de Live pour quitter le mode de
Mapping. Appuyez maintenant sur les contacteurs au pied A, B et C du FBV pour les essayer. Live doit réagir en conséquence ! Répétez les étapes précédentes, et affectez le contacteur “D” à n’importe quel contacteur/interrupteur dans Live. Remarque : Live possède un bouton séparé de Play et de
Stop, avec chacun un mode de commutation de CC MIDI de type “Single”. Dans certaines applications les fonctions Play/Stop sont regroupées sous un même bouton. Dans ce cas, vous pouvez modifier le mode de commutation du contacteur du FBV en mode “Toggle” dans le logiciel FBV Control.
Certaines applications répondent aux messages MMC ou Mackie à la place des messages de CC MIDI pour les fonctions de transport. Consultez le mode d’emploi de votre logiciel. Notez que rien ne vous empêche d’affecter le même contrôleur FBV à plusieurs paramètres de votre logiciel
MIDI/audionumérique. Le FBV contrôle alors tous ces paramètres en même temps. Ce qui est peut être ce que vous recherchez. Ou pas... Par exemple, il peut être utile d’affecter un contacteur FBV aux touches de transport Play et Record, ce qui vous permet d’activer/désactiver simultanément les deux
fonctions. Assignation des pédales du FBV aux paramètres de Live Affectons les réglages de pédale du FBV. Les contrôleurs “Pédale Wah” et “Pédale Volume” FBV transmettent chacun un flux de données de CC MIDI, que vous pouvez assigner à n’importe quel paramètre de Live offrant la même plage
(un bouton ou un curseur, par exemple), pour le contrôler en temps réel. Commençons par assigner le contrôleur FBV Pedal Wah au Chorus de Live, paramètre Dry/ Wet. Ceci vous permet de modifier le mélange son non traité/son traité de l’effet de Chorus en temps réel. Notez que ceci permet
également d’enregistrer l’automation des variations d’effet en temps réel avec la pédale du FBV. Nous y reviendrons plus tard... • Sur le FBV, placez la pédale sur “Wah” (la Led Wah s’allume). Sinon, appuyez au maximum sur la pédale et cliquez le contacteur de la pointe du pied. • Dans Ableton Live,
enregistrez une piste ou chargez un fichier audio dans une piste audio. • Chargez le Chorus en insertion sur la piste audio. Sélectionnez Effects>Chorus>Chorus dans le menu Live Devices et déposez le Chorus sur la piste audio pour l’insérer. 6•8 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles Placez le Chorus sur votre piste Audio pour l’insérer. • Vous pouvez voir l’effet de Chorus s’afficher dans la fenêtre inférieure de Live. Placez Live en mode d’assignation MIDI (voir les instructions en début de section). Une fois en mode de Mapping, Map Mode, vous
pouvez voir les paramètres contrôlables par MIDI pour l’effet de Chorus. • Nous allons assigner le bouton Chorus Dry/Wet. Cliquez sur le bouton pour que Live attende la réception de la commande du contrôleur MIDI. Déplacez la pédale du FBV jusqu’à ce que le texte en bas de l’écran de Live vous
indique que le paramètre Dry/Wet ait été assigné : Cliquez sur le bouton Dry/Wet. Le texte du bas signifie que Live attend que vous appuyiez sur un contrôleur du FBV pour l’assigner. Le canal/CC MIDI est affiché. Le texte donne les détails de l’assignation MIDI. • Étant donné que nous avons assigné la
Pédale Wah du FBV au CC MIDI 5, le bouton de Mix du Chorus de Live est assigné au canal 1, CC 5. 6•9 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Quittez le mode d’assignation MIDI de Live et essayez ! Le bouton Dry/Wet du Chorus devrait répondre aux
mouvements de la pédale du FBV ! À vous ! Sélectionnez la pédale de volume du FBV de sorte que la Led “VOL” s’allume et assignez la pédale de volume à un autre paramètre de Live. Vous pouvez ensuite contrôler l’un ou l’autre des paramètres en passant de la pédale de Wah à la pédale de volume
(utilisez le contacteur de la pointe du pied). Utilisateurs du FBV Shortboard MkII : Si vous avez une pédale d’expression externe connectée, procédez comme suit pour contrôler un autre paramètre ! Contrôle MIDI d’un paramètre d’effet AU/VST Comme avec la plupart des logiciels audionumériques,



Ableton Live vous permet d’assigner un contrôleur du FBV au contrôle d’un paramètre d’un Plug-In AU ou VST. Dans cet exemple, nous allons assigner la pédale Wah du FBV à la position de la pédale Wah du Plug-In Line 6 POD Farm. Ceci vous permet d’utiliser la pédale du FBV pour contrôler l’effet
Wah de POD Farm en temps réel ! Ces étapes sont identiques dans le Plug-In Line 6 POD GearBox, ou tout autre Plug-In AU ou VST. • Allumez la Led “WAH” du FBV, pour sélectionner la pédale de Wah. • Dans Live, enregistrez ou chargez une piste audio. Une rythmique de guitare claire serait parfaite
pour cet exemple. Voici la fenêtre “Arrangement” de Live : • Dans la fenêtre de navigateur des Plug-Ins de Live, sélectionnez votre Plug-In et déposez-le sur la piste audio. • Le module d’effets se charge dans le panneau inférieur de Live. Si vous cliquez sur la petite flèche en haut de ce module d’effet, il
affiche l’option Configure. Ceci vous permet d’ajouter les paramètres de la fenêtre d’édition du Plug-In pour qu’ils soient accessibles à l’intérieur de la fenêtre d’affichage du module d’effet. 6•10 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cliquez sur la flèche pour
déployer la Cliquez sur Configure pour ajouter fenêtre de l’effet... un paramètre de Plug-In POD Farm à cet effet. Dans la fenêtre du Plug-In POD Farm, cliquez directement sur le bouton de position de Wah pour sélectionner le paramètre. Une fois le paramètre du Plug-In sélectionné, un curseur
s’affiche. • Suivez les mêmes étapes que dans les exemples précédents pour passer en mode de Mapping MIDI de Live, cliquez sur le paramètre du module d’effets, puis déplacez la pédale du FBV pour l’assigner. Dans cet exemple, nous avons assigné le CC MIDI 5, canal 1, de la pédale du FBV au
paramètre de position de la Wah. Quittez le mode de Mapping MIDI. Allez-y et cliquez sur Play dans Live et utilisez la pédale du FBV pour modifier le paramètre assigné. Vous pouvez également voir le paramètre varier dans la fenêtre, dans notre cas, le bouton de position de la Wah du Plug-In POD
Farm. Attendez, il y a encore mieux à venir, alors ne bougez pas ! 6•11 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Gestion de l’enregistrement des automations avec la pédale du FBV Une fois un paramètre assigné à la pédale FBV, la plupart des logiciels
audionumériques vous permettent également “d’enregistrer” les mouvements de la pédale en temps réel sous la forme d’une enveloppe d’automation sur la piste. Dans cet exemple, nous allons utiliser le Mapping de Wah de POD Farm, et nous allons enregistrer les déplacements de la pédale de Wah du
FBV pour ajouter des plans de Wah sur notre piste de guitare. Certaines applications audionumériques sont différentes, alors consultez la documentation de votre logiciel audionumérique. Cet exemple devrait vous donner une idée précise. Maintenant que la pédale du FBV est assignée à la Wah du
Plug-In POD Farm (ou du Plug-In de votre choix) allons-y... • Dans la fenêtre d’arrangements de Live, veillez à ce que la piste audio ne soit pas armée en enregistrement (étant donné que nous souhaitons enregistrer uniquement l’automation sur cette piste, pas de signaux audio). Vous devriez également
voir le paramètre Wah du POD Farm sur la piste. Notez que pour l’instant, lorsque vous déplacez la pédale du FBV, une ligne d’enveloppe plate se déplace sur la piste. Désarmez l’enregistrement de la piste. Une fois le paramètre de position de Wah de POD Farm assigné (exemple précédent), la piste
audio de Live affiche le paramètre dans le sélecteur d’automation, et une ligne d’enveloppe. La ligne se déplace avec le mouvement de la pédale du FBV. • Revenez au début de la piste, cliquez sur la touche Record de Live et puis sur Play. Une fois que Live tourne, utilisez la pédale du FBV : les
mouvements de la pédale sont enregistrés sur la piste. Vous pouvez voir des points d’édition de la courbe d’enveloppe ajoutés au fur et à mesure. • Arrêtez Live et lancez la lecture de la piste : vous pouvez entendre le jeu à la Wah, enregistré en temps réel. Pas content de votre enregistrement ?
Annulez, ou zoomez et éditez les points d’enveloppe à la main. 6•12 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles GarageBand® d’Apple — Tutoriel d’utilisation avec le FBV MkII GarageBand d’Apple utilise son propre protocole pour contrôler la plupart de ses
paramètres. Par conséquent, les contrôleurs MIDI du FBV MkII ne peuvent pas télécommander directement toutes les fonctions de GarageBand. Ceci dit, voici quelques assignations de pédale qui vous permettront de contrôler les paramètres de volume et de panoramique des pistes de GarageBand. De
plus, il y a des Plug-ins que vous pouvez installer sur votre Mac® qui vous permettent d’utiliser les contacteurs au pied du FBV pour contrôler les fonctions de transport de GarageBand. Pour configurer les pédales du FBV, lancez le logiciel Line 6 FBV Control et chargez le Preset “FBV- Default.fbv”... •
Réglez la pédale Wah sur le CC 010. • Laissez la valeur de pédale de volume sur le CC MIDI 007. • Notez que les pédales sont également configurées pour transmettre sur le port USB MIDI Out 1. Les réglages devraient être les suivants : Ouvrez simplement GarageBand et chargez l’un de vos
morceaux. Lorsque vous déplacez la pédale du FBV, réglée sur “Volume”, elle doit modifier le volume de la piste sélectionnée, et lorsque la pédale est en position Wah, elle doit contrôler le panoramique de la piste. Si vous utilisez un pédalier Shortboard avec une pédale d’expression externe, vous
pouvez régler la pédale 2 sur le CC MIDI 010, utiliser la pédale de volume pour contrôler le volume de la piste, et la pédale 2 pour contrôler le panoramique de la piste. Afin de contrôler les fonctions de transport de GarageBand avec le FBV vous devez utiliser la version 2.0.1 ou plus récente de
Garageband. Vous devez également utiliser l’application Line 6 FBV Control pour définir les contacteurs du FBV que vous souhaitez utiliser pour contrôler les fonctions de transport de GarageBand et régler leurs valeurs de CC MIDI, et leurs paramètres Switch Type sur “Momentary”. Garageband ne
permet pas directement la gestion des autres paramètres, mais vous le pouvez en téléchargeant d’autres applications permettant de gérer GarageBand par messages MIDI. GarageRemote est l’un de ces logiciels, et il est disponible sur le site : otherstuff/garageremote/. Une fois GarageRemote installé et
configuré, lancez la fonction ‘Listener’ GarageRemote (désactivée par défaut) pour transmettre les ordres MIDI à GarageBand. GarageBand répond aux CC MIDI 007 et 010 pour le volume et le panoramique de la piste en cours. Vous pouvez utiliser le logiciel Line 6 FBV Control pour créer ces
configurations de CC MIDI, et les sauvegarder sous la forme de Presets FBV que vous pouvez recharger quand vous le souhaitez. 6•13 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Apple Logic® — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et
les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour déclencher les fonctions de transport de Logic, régler les Faders de mixage, les instruments virtuels, les paramètres de Plug-In et plus encore ! Voici les instructions de configuration du FBV MkII avec Logic Pro 8 (la procédure devrait être
assez similaire avec des versions plus récentes de Logic). Réglages dans Line 6 FBV Control Lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous
voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Logic. • Notez que certains contacteurs au pied (B, C, D et autres) sont réglés pour transmettre des commandes MMC (MIDI
Machine Control. Celles-ci peuvent être configurées aux réglages de transport de Logic. Vous pouvez aussi configurer d’autres contrôleurs pour qu’ils transmettent les messages MMC pour contrôler les fonctions de transport de Logic si vous le souhaitez. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “Logic.fbv” semble une bonne idée... Assignation des contrôleurs avec la fonction d’apprentissage MIDI de Logic Logic Pro est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui
ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Logic. Ceci dit, vous pouvez facilement
assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Logic ou des Plug-Ins, grâce à la fonction d’apprentissage MIDI de Logic (MIDI Learn) ! Nous allons vous montrer comment assigner la pédale du FBV au paramètre de position de Wah d’un Plug-In POD Farm AU inséré sur une
piste. Vous pouvez ensuite assigner n’importe quel contrôleur de votre pédalier FBV à la télécommande des fonctions de Logic. Il est conseillé de lire la documentation sur les surfaces de contrôle dans le manuel de Logic ainsi que sur la fonction d’apprentissage MIDI de Logic. 6•14 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Pour commencer, voici une petite astuce pratique dans Logic... La zone de transport de Logic Pro vous indique lorsque vous recevez des données MIDI, avec le canal MIDI, le type de commande et la valeur. Par exemple, regardez les
informations de transport et activez un contacteur ou bougez une pédale du FBV : les informations MIDI s’affichent. Dans cette illustration, nous avons déplacé la Wah au maximum : la zone MIDI In indique que Logic a reçu sur le canal MIDI 1, un message de CC 11 avec une valeur de 127: Ces
informations sont très utiles pour confirmer la réception par Logic des données MIDI du FBV, en particulier avec le détail de la commande MIDI et des valeurs sans avoir à revenir au logiciel Line 6 FBV Control ! Dans cet exemple, assignons la pédale du FBV au paramètre de position de Wah du Plug-In
POD Farm. Si vous n’avez pas le Plug-In POD Farm, vous pouvez insérer un Plug-In Logic ou Audio Units... • Assurez-vous que la pédale du FBV soit réglée sur “Pedal Wah” (la Led Wah du FBV doit être allumée). • Créez une piste audio dans votre session Logic, et enregistrez ou insérez un fichier
audio pour utiliser votre Plug-In d’effet. Une guitare claire serait parfaite. • Cliquez sur une insertion d’effets de la piste Logic Audio et insérez le Plug-In POD Farm. • Dans la fenêtre du Plug-In POD Farm, chargez un Preset Tone et ajoutez l’un des modèles de Wah à votre son. Cliquez sur la Wah à
l’intérieur de l’écran du trajet du signal pour afficher les menus d’édition de la Wah. Bouton de position de Wah. Plug-In POD Farm, fenêtre d’édition, effet de Wah • Cliquez directement sur le bouton de position de la Wah de POD et déplacez-le un peu. Ceci permet de sélectionner le paramètre de
position de Wah. • Ensuite (avant de cliquer où que ce soit), allez dans Logic > Preferences > Control Surfaces, et sélectionnez Learn Assignment for “Wah - Position”. • Comme vous pouvez le voir avec la commande “Learn Assignment...”, Logic détecte automatiquement le paramètre “Wah - Position”
du Plug-In POD Farm, car c’est celui qui a été sélectionné à la souris en dernier. 6•15 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles ASTUCE : Vous pouvez aussi utiliser le raccourci Command+L plutôt que d’aller dans le menu des préférences de Logic. • Lorsque
vous sélectionnez la commande “Learn Assignment...”, vous lancez la fenêtre des assignations des contrôleurs de Logic, et un message vous informe que l’application attend que vous accédiez à votre contrôleur MIDI pour “apprendre” la commande MIDI. Notez que la fenêtre Controller Assignment offre
également une option élaborée “Expert View” avec plus d’options et vous permettant d’assigner manuellement vos contrôleurs MIDI. Consultez la documentation de Logic! La fenêtre simplifiée est parfaite pour assigner instantanément vos contrôleurs MIDI. • Déplacez la pédale du FBV, et vous devriez
voir la fenêtre Controller Assignment recevoir et “apprendre” le message de contrôle MIDI (configuré pour transmettre un CC MIDI 11, avec une plage de valeurs de 0 - 127, dans le Preset FBV-Default sélectionné dans Line 6 FBV Control). Vous pouvez voir la commande de contrôleur MIDI “apprise”. •
Quittez la fenêtre Controller Assignments et déplacez la pédale du FBV. Vous devriez voir le bouton Position à l’intérieur de la fenêtre du Plug-In GearBox se déplacer. Appuyez sur Play dans Logic pour écouter votre piste audio : lorsque vous déplacez la pédale, vous devriez entendre la Wah sur votre
piste ! • Notez que vous pouvez également configurer la piste audio pour enregistrer les données d’automation pour le Plug-In POD Farm, paramètres de position de Wah, et vous pouvez ainsi enregistrer le jeu à la Wah en temps réel. Vous devriez appliquer ce que vous venez d’apprendre à n’importe
quel autre paramètre de Logic : Faders de mixage, panoramiques, touches Solo, instruments virtuels, autres paramètres de Plug-In, etc. 6•16 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Contrôle des fonctions de transport de Logic Pour configurer les contacteurs
de votre FBV pour qu’ils gèrent les fonctions de transport de Logic contrôle, vous devez configurer Logic pour “écouter” les commandes MMC affectées aux contacteurs de votre FBV... • Lancez Logic et allez dans Preferences > MIDI. • Sélectionnez l’onglet Sync. • Cliquez sur MIDI Sync Project
Settings… en bas à droite de l’onglet the Sync : ceci affiche la fenêtre Song Settings. • Dans la section MIDI Machine Control (MMC), sélectionnez Listen to MMC Input. Notez que cette option est spécifique à chaque morceau dans Logic. Pour que cette option devienne “globale”, vous devez modifier le
fichier Template de Logic avec ces réglages MMC. 6•17 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Cakewalk SONAR™ — Tutoriel d’utilisation avec le FBV MkII Les contacteurs au pied et les pédales du pédalier Line 6 FBV MkII peuvent être utilisés pour
déclencher de nombreuses fonctions de Cakewalk SONAR, régler les instruments virtuels, les paramètres de Plug- In et plus encore, grâce à la fonction ACT (Active Controller Technology) de SONAR ! Voici les instructions de configuration du FBV MkII avec SONAR 8 Producer (la procédure devrait
être assez similaire avec des versions plus récentes de SONAR). Réglages dans Line 6 FBV Control Avant de lancer SONAR, connectez le FBV au port USB de votre ordinateur, lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-
Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans SONAR. • Si vous modifiez les réglages dans FBV
Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset. Le nom “SONAR.fbv” semble une bonne idée.... • Quittez FBV Control. Configuration des périphériques MIDI de SONAR Afin de configurer SONAR pour qu’il reçoive les données de contrôleur MIDI du pédalier FBV
MkII, vous devez sélectionner le périphérique dans le menu SONAR MIDI Device Settings. Veillez à ce que le FBV soit toujours connecté au port USB avant de lancer SONAR. Lancez SONAR et allez dans SONAR Options/MIDI Devices et sélectionnez le premier port FBV MIDI Out comme périphérique
d’entrée MIDI In. Sélectionnez OK. 6•18 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Notez que si vous utilisez Windows® 7 ou Windows Vista®, le nom de vos ports de sorties MIDI peuvent s’afficher sous le nom de “FBV Shortboard MIDI Out” ou “FBV Express
MkII MIDI Out”. Utilisation du pédalier FBV MkII comme surface de contrôle dans SONAR SONAR possède sa propre fonction ACT MIDI Controller Plug-In, qui vous permet de facilement créer, personnaliser et sauvegarder les assignations de n’importe quelle surface de contrôle MIDI. La fonction
SONAR ACT est très puissante. Lisez la documentation de SONAR. Nous allons vous montrer comment créer vos affectations de contacteurs au pied ou de pédale du FBV. Ouvrez ou créez un nouveau projet dans SONAR, et procédez comme suit... • Allez dans SONAR Options > Controllers/Surfaces.
• Dans le menu Controllers/Surfaces, cliquez sur “Add new Controller/Surface”. Dans Controllers/ Surfaces, sélectionnez “ACT MIDI Controller”, et dans Input Port sélectionnez le premier port de sortie FBV MIDI Out. Vous pouvez régler l’option Output Port sur “None”, puis cliquez sur “OK”. Les réglages
doivent ressembler à ceci : • Fermez la fenêtre Controllers/Surfaces. • Ensuite, allez dans Views > Toolbars et sélectionnez la case Controllers/Surfaces, puis fermez la fenêtre. Ceci ajoute quelques options ACT à la barre d’outils de SONAR. 6•19 Mode d’emploi détaillé des pédaliers FBV MkII —
Gestion des applications logicielles • Dans les options de barre d’outils ACT Controllers, cliquez sur Controllers/Surfaces Properties, à droite. • Dans la fenêtre ACT MIDI, sélectionnez le Preset Default dans le menu Presets. Lorsque ce Preset est chargé, les cellules vous renseignent sur de nombreux
paramètres de SONAR. Lorsque vous cliquez sur une fenêtre d’édition de Plug-In ou d’instrument virtuel, les paramètres du Plug- In/instrument deviennent disponibles dans la fenêtre ACT. Ceci dit, les contrôleurs du FBV ne sont pas encore assignés à ces paramètres avec le Preset Default. Pour cela,
vous pouvez utiliser la fonction d’apprentissage MIDI (MIDI Learn). Fenêtre ACT MIDI. Preset Default sélectionné Utilisation de la fonction d’apprentissage MIDI SONAR ACT Voici comment assigner la pédale Wah du FBV pour contrôler le paramètre de position de Wah du Plug-In Line 6 GearBox, vous
permettant de télécommander la Wah de GearBox en temps réel tout en écoutant le signal d’entrée ou le signal de la piste audio. La procédure d’assignation est la même pour affecter tous les boutons, touches, aux paramètres disponibles dans la fenêtre ACT MIDI Controller... • Ouvrez la fenêtre
SONAR ACT MIDI Controller avec le Preset Default chargé, comme décrit ci-dessus. Laissez cette fenêtre ouverte où vous pouvez la voir. • Créez une piste audio dans le projet SONAR, et enregistrez ou insérez un fichier audio pour pouvoir écouter le résultat sur le Plug-In. Une guitare claire serait
parfaite. • Cliquez sur une insertion FX Bin Insert de la piste audio et insérez le Plug-In GearBox. • Dans la fenêtre du Plug-In GearBox, chargez un son Tone Preset, et cliquez sur l’effet de Wah. Vérifiez que l’effet soit actif et que les réglages soient affichés dans la fenêtre d’édition. 6•20 Mode d’emploi
détaillé des pédaliers FBV MkII — Gestion des applications logicielles Fenêtre d’édition de GearBox, effet de Wah • Vous devriez maintenant voir les nombreux paramètres du Plug-In GearBox dans les cellules de la fenêtre ACT. Nous souhaitons utiliser le paramètre Wah - Position. Sélectionnez la
Banque 4 dans la rangée supérieure des cellules “Rotary”, et le paramètre Wah - Position devrait s’afficher dans la zone du contrôleur rotatif (Rotary) 1. Le Preset Default est sélectionné... Dans l’onglet Controllers, sélectionnez la banque 4 pour la rangée supérieure des cellules. Le paramètre Wah-
Position du Plug-In GearBox s’affiche dans la zone Rotary 1. • Cliquez la cellule inférieure de la zone Rotary 1 et sélectionnez le mode “MIDI Learn”. Le logiciel attend de recevoir une commande MIDI du pédalier FBV... • Déplacez la pédale Wah du FBV : la zone Rotary 1 doit quitter le mode MIDI Learn,
signifiant que la commande MIDI a été “apprise”, et que le contrôleur est affecté au paramètre. • Déplacez la pédale et vous devriez voir le gros bouton de position de Wah se déplacer dans la fenêtre du Plug-In GearBox. Écoutez votre piste et appréciez la Wah ! • Répétez les étapes ci-dessus pour
utiliser la fonction MIDI Learn et assigner d’autres contrôleurs du FBV MkII aux paramètres de Plug-in, ou d’instruments de SONAR. Lorsque vous avez terminé, saisissez un nouveau titre dans le champ Preset, en haut de la fenêtre ACT et cliquez sur Save pour sauvegarder tous les réglages
d’assignation dans un Preset SONAR ACT. La fonction SONAR ACT offre d’autres fonctions très astucieuses pour la gestion du MIDI. Consultez la documentation d’aide de SONAR ! 6•21 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Propellerhead Reason® —
Tutoriel d’utilisation avec le FBV MkII Bien sûr, les pédaliers FBV MkII n’offrent pas les notes et boutons du contrôleur clavier Line 6 KB37, pour jouer des instruments de Reason, enregistrer des pistes MIDI, etc. Ceci dit, les pédaliers FBV MkII sont équipés de contacteurs au pied et d’une pédale (ou
deux), que vous pouvez utiliser pour déclencher et contrôler de nombreux paramètres de Reason ! Pour configurer un pédalier FBV pour cette utilisation, vous devez le configurer dans Reason comme “surface de contrôle MIDI générique” (cela nous fait de la peine de voir nos pédaliers qualifiés de
«génériques»...). Suivez ces étapes qui sont identiques dans Windows® ou dans Mac OS® X, sauf indication... • Dans la fenêtre Preferences, sélectionnez Keyboards et Control Surfaces, cliquez sur Add, puis sélectionnez dans la liste des périphériques. • Faites les réglages suivants dans la fenêtre
Control Surface: Sélectionnez MIDI Control Surface dans la zone Model. Saisissez un nom pour le périphérique (nom qui s’affiche dans les menus des contrôleurs MIDI de Reason). Sélectionnez le port USB MIDI de réception pour Reason. Sélectionnez le premier port de sorties FBV MIDI Out (notez
que les noms de ports s’affichent différemment sous Mac® et sous Windows® - voir page 6•1). Cliquez sur OK lorsque vous avez terminé. • 6•22 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Vous devriez maintenant voir le pédalier FBV configuré. Quittez les
Preferences si tous les réglages s’affichent comme suit : Consultez la section suivante pour assigner les contrôleurs MIDI du FBV aux paramètres de Reason. Configuration des contrôleurs MIDI du FBV avec apprentissage Remote Override Reason possède également une fonction “Remote Override”,
qui permet à Reason “d’apprendre” les messages MIDI en provenance de votre contrôleur MIDI et qui sont instantanément assignés aux paramètres de Reason. Vous pouvez utiliser les options Remote Override pour votre pédalier FBV MkII lorsqu’il est configuré comme périphérique de contrôle MIDI
générique. Pour commencer, vérifiez que les contacteurs et la pédale du FBV soient configurés pour transmettre les messages de CC MIDI sur le canal MIDI sélectionné dans la fenêtre de contrôleur MIDI générique. Fermez Reason, lancez Line 6 FBV Control et chargez le Preset “FBV-Default.fbv”... •
Lorsque le Preset FBV-Default est chargé, vous pouvez voir que le contrôleur Pedal Vol du FBV est prêt à transmettre un message MIDI de CC 007. Notez que la pédale de volume est réglée pour transmettre ses commandes sur le port FBV MIDI Out 1, ce qui est parfait, car c’est le port que nous avons
sélectionné dans le menu Reason Generic Controller pour que Reason reçoive les ordres MIDI. Quittez FBV Control. Utilisons la pédale pour gérer un paramètre de Reason. • Assurez-vous que la pédale du FBV soit réglée en volume (témoin “Volume” allumé). • Lancez Reason et chargez l’un de vos
projets Reason. Cliquez avec le bouton droit de la souris (Windows) ou faites un Ctrl-clic (Mac) sur n’importe quel bouton ou curseur de Reason que vous souhaitez contrôler avec la pédale. Sélectionnez le bouton FREQ de l’un des synthés de Reason... 6•23 Mode d’emploi détaillé des pédaliers FBV
MkII — Gestion des applications logicielles Cliquez avec le bouton droit de la souris directement sur le bouton que vous souhaitez contrôler... Sélectionnez ensuite Edit Remote Override Mapping... • Dans la fenêtre, sélectionnez la case “Learn From Control Service” et Reason attend de recevoir un
message de CC MIDI en provenance de la surface de contrôle (le FBV). Déplacez la pédale du FBV et vous devriez voir la zone Control Surface Active recevoir un signal MIDI. Ensuite, les champs Control Surface et Control prennent automatiquement le nom du périphérique MIDI, avec la valeur de CC,
comme indiqué. Cliquez sur OK. • Ca y est ! Si vous déplacez la pédale, vous devriez voir le bouton sélectionné se déplacer. Vous pouvez suivre les mêmes étapes et assigner de nombreux contrôleurs FBV directement à n’importe quel bouton, commutateur, curseur, etc., de Reason. La fonction Reason
Remote Override offre d’autres fonctions - consultez l’aide de Reason pour optimiser l’utilisation de vos contrôleurs MIDI Line 6 ! 6•24 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Transports de Pro Tools® LE — Tutoriel d’utilisation avec le FBV MkII Voici un
tutoriel pas-à-pas pour configurer un FBV Shortboard ou un Express MkII afin de contrôler les fonctions de transport de Digidesign Pro Tools LE 8 (ces étapes sont identiques avec d’autres versions de Pro Tools). La configuration d’un contrôleur MIDI comme les pédaliers FBV MkII dans Pro Tools n’est
pas évidente, mais reste simple une fois que vous savez quoi faire. Il peut être très utile de pouvoir contrôler les fonctions de transport au pied pour l’enregistrement et les Punch-ins ! Remarque : Les étapes suivantes sont identiques sous Mac®, Windows® XP, Windows® 7 ou Vista®, à moins
d’indication contraire. Configuration des contrôleurs du FBV La première étape, avant même de lancer Pro Tools, consiste à configurer des affectations MIDI pour les contrôleurs et pédales de votre FBV. Pro Tools utilise le protocole MIDI Machine Control (MMC) pour contrôler ses paramètres. Par
conséquent, nous allons assigner les commandes MMC aux contacteurs du FBV dans Line 6 FBV Control, puis nous allons les sauvegarder dans un Preset FBV. On y va... • Connectez le FBV MkII à votre ordinateur et lancez Line 6 FBV Control. • Allez dans File > Open et chargez le Preset “Blank.fbv”.
• Allez dans File > Save As et appelez le nouveau Preset “PT-Transport.fbv”. Dans cet exemple, nous allons configurer plusieurs contrôleurs FBV comme suit (vous pouvez en faire de même sur votre pédalier FBV Shortboard ou Express MkII) : • Configurez les contacts A, B, C & D sur “MMC”. • Réglez la
valeur du contacteur A sur “Play”. • Réglez la valeur du contacteur B sur “Stop” • Réglez la valeur du contacteur C sur “Record Punch (Pro Tools)” • Réglez la valeur du contacteur D sur “Rewind”. Notez que pour la fonction Rewind, vous pouvez sélectionner un mode Switch, avec chacun un
fonctionnement différent : • “Single” lance le retour en arrière à chaque pression sur le contacteur au pied, et continue de rembobiner. • “Momentary” lance le retour en arrière à chaque pression sur le contacteur au pied, mais cesse de rembobiner lorsque vous relâchez le contacteur. • “Toggle” alterne
entre le rembobinage et l’arrêt à chaque pression sur le contacteur. • Vous pouvez aussi assigner la valeur d’avance rapide “Fast Forward” à l’un de ces contacteurs (ou à un autre dans le cas du Shortboard). Ceci dit, notez que la valeur MMC “Pause” est identique à la fonction “Stop” (il n’y a pas de
touche Pause dans Pro Tools). • Réglez tous les canaux de sorties sur “1”, car nous voulons transmettre toutes les données MIDI sur le port FBV USB MIDI 1, canal 1. • Tous les autres réglages du FBV sont placés sur Unassigned car nous ne les utilisons pas. 6•25 Mode d’emploi détaillé des pédaliers
FBV MkII — Gestion des applications logicielles Le résultat devrait ressembler à ceci : • Lorsque vous avez terminé, sauvegardez, quittez Line 6 FBV Control et laissez le FBV connecté à votre ordinateur. Configuration de Pro Tools LE pour les pédaliers FBV MkII Nous devons maintenant faire quelques
réglages dans Pro Tools pour qu’il réagisse aux messages MMC du pédalier FBV MkII. Lancez Pro Tools et ouvrez ou créer une nouvelle session, puis faites les réglages suivants... • Allez dans le menu Setup et sélectionnez Peripherals. • Dans la fenêtre Peripherals, sélectionnez la zone Machine
Control et réglez comme suit : • Pour MIDI Machine Control (Master) - activez la case Enable, cliquez sur le menu de droite et dans le menu “Predefined”, sélectionnez le pédalier FBV MkII connecté, et réglez la valeur ID sur 125. Gardez le Preroll sur 90 Frames. • Pour le réglage MIDI Machine Control
(Slave) - activez la case Enable, et laissez la valeur ID sur 126. • Quittez la fenêtre Peripherals. 6•26 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Nous devons ensuite accéder au petit menu “Pro Tools” dans la zone de Transport... Dans Pro Tools - sous-menu
Transport, sélectionnez “Pro Tools”. Dans Pro Tools - sous-menu Online, sélectionnez “MMC” . ...C’est tout ! Appuyez sur les contacteurs au pied A, B, C & D du FBV : il doivent contrôler les fonctions de transport de Pro Tools. 6•27 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des
applications logicielles Steinberg Cubase® — Tutoriel d’utilisation avec le FBV MkII Les pédaliers Line 6 FBV MkII peuvent contrôler de nombreux paramètres de Cubase, ce qui comprend les fonctions de transport, les paramètres de mixage et plus encore ! Voici les instructions de configuration du FBV
MkII avec Steinberg Cubase® 4 pour Windows®. Ceci dit, les procédures devraient être très similaires avec les versions plus récentes de Cubase et de Nuendo® sous Windows® et Mac®. Réglages dans Line 6 FBV Control Avant de lancer CUBASE, connectez le FBV au port USB de votre ordinateur,
lancez Line 6 FBV Control et chargez le Preset FBV-Default.fbv. • L’illustration ci-dessus montre les réglages du Preset FBV-Default avec un pédalier FBV Shortboard MkII. Avec le FBV Express MkII, vous voyez uniquement la rangée des contacteurs A, B, C, D et de la pédale. Ce Preset affecte pour
nous les commandes MIDI à tous les contrôleurs MIDI, puis les assigne dans Cubase. • Les étapes ci-dessus assignent des commandes MIDI aux contrôleurs MIDI de sorte que nous puissions les assigner aux fonctions de Cubase. Elles configurent certains contacteurs du FBV pour transmettre des
messages MMC (MIDI Machine Control) pour contrôler les fonctions de transport de Cubase, et des messages de CC MIDI pour déclencher d’autres fonctions de Cubase. • Si vous modifiez les réglages dans FBV Control, allez dans File > Save As et sauvegardez les réglages sous un nouveau Preset.
Le nom “Cubase.fbv”semble une bonne idée... • Quittez FBV Control. Configuration des ports MIDI de Cubase Étant donné que vous utilisez le pédalier FBV MkII comme contrôleur MIDI, vous devez l’exclure du réglage de port MIDI “All Inputs”. De cette façon, si vous sélectionnez l’option “All Input” pour
l’une de vos pistes MIDI, la piste ne reçoit pas de signaux du pédalier FBV et n’enregistre pas les données de contrôleur MIDI dans la piste. Pour configurer ce réglage, allez dans la fenêtre Devices > Device Setup de Cubase. Étant donné que les réglages de Line 6 FBV Control sont configurés pour
transmettre sur le port FBV USB MIDI Out 1, nous pouvons sélectionner le premier port MIDI FBV dans Cubase, et dé-sélectionner les ports MIDI FBV 2, 3 & 4. 6•28 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez MIDI Port Setup Dé-sélectionnez “All
Inputs” sur tous les ports USB MIDI FBV Sélectionnez le premier port MIDI USB FBV, et dé- sélectionnez les ports FBV 2, 3, & 4 Notez qu’étant donné que nous utilisons Windows® XP dans cet exemple, les ports MIDI FBV s’affichent sous la forme “USB Audio Device”. Le nom est différent avec
Windows® 7, Windows Vista® ou Mac OS® X (voir page 6•1). Gestion des paramètres de Cubase Cubase est compatible avec l’utilisation de plusieurs surfaces de contrôle MIDI, qui ressemblent à des processeurs matériels avec de nombreux Faders, boutons et autres contrôleurs pour émuler une
console de mixage analogique de grande taille. Les pédaliers Line 6 FBV MkII ne font pas partie des surfaces de contrôle gérées directement par Cubase. Ceci dit, vous pouvez facilement assigner les contrôleurs des pédaliers FBV à la gestion des paramètres de Cubase. Ceci est possible en
configurant votre pédalier FBV MkII comme contrôleur “Générique”. Allez dans le menu de Cubase Devices > Device Setup... • Si vous ne voyez pas “Generic Remote” dans la zone Remote Devices de gauche, cliquez sur “+” en haut à gauche de la fenêtre et sélectionnez Generic Remote dans le menu
pour l’ajouter. Sélectionnez Generic Remote Sélectionnez le premier port USB MIDI 6•29 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles • Dans la zone supérieure droite vous pouvez voir la liste des paramètres de Cubase que vous pouvez contrôler avec le FBV. La
façon la plus simple consiste à utiliser la fonction Learn. Par exemple, pour assigner le “Fader 1” en haut de la liste à la pédale de volume du FBV : • Assurez-vous que la pédale du FBV soit réglée sur Pedal Vol (la Led “Volume du FBV doit être allumée). • Dans la fenêtre Cubase Device Setup, cliquez
directement sur nom de contrôle “Fader 1” en haut à droite de la fenêtre. • Déplacez la pédale du FBV. • Appuyez sur Learn à droite. • Vous devriez voir le canal MIDI et d’autres réglages dans la rangée Fader 1 changer, ce qui indique que le message de CC MIDI transmis par la pédale du FBV a été
transmis et “appris” (dans ce cas le CC MIDI 011, sur le port MIDI 1, canal 1, selon les réglages de Line 6 FBV Control). • Regardez la fenêtre du mélangeur de Cubase et regardez la voie de la piste 1 - vous devriez voir le Fader répondre aux mouvements de la pédale du FBV. • Faites-en de même avec
d’autres contrôleurs en les assignant à d’autres paramètres de Cubase dans la liste. • Notez que vous devez assigner des pédales à la gestion des boutons, curseurs et Faders de Cubase, et des contacteurs aux commutateurs de Cubase. • De la même façon, les paramètres de Cubase ont besoin de
recevoir des messages de type CC MIDI, alors assurez-vous que les pédales et contacteurs du FBV transmettent ce type de messages MIDI, dans le logiciel Line 6 FBV Control. La zone inférieure droite vous permet également d’assigner d’autres contrôleurs MIDI aux paramètres de voies, au-delà des
pistes 1 - 16. Il est également possible de personnaliser ces listes de paramètres génériques avec les options de la fenêtre. Consultez la documentation de Cubase. Cubase Transport Control Cubase permet la gestion par MIDI de ses réglages de transport par de simples messages MIDI de Machine
Control Slave, ce qui signifie qu’il répond aux commandes MMC d’un contrôleur sélectionné. Étant donné que nous avons assigné des commandes MMC à plusieurs contacteurs au pied du FBV dans le logiciel FBV Control, tout ce que nous avons besoin de faire est de configurer Cubase pour qu’il
réagisse aux commandes MMC transmises par votre pédalier FBV MkII. Allez dans le menu Transport de Cubase et sélectionnez Project Synchronization Setup... 6•30 Mode d’emploi détaillé des pédaliers FBV MkII — Gestion des applications logicielles Sélectionnez la case MMC Slave Active.
Sélectionnez le premier port MIDI USB FBV MIDI en entrée MIDI. Cliquez sur OK et quittez la fenêtre. Essayez les contacteurs de votre FBV assignés aux commandes MMC, et vous devriez voir Cubase réagir en conséquence. Avec les exemples utilisant des Plug-Ins de ce chapitre, vous devriez être
prêt à utiliser votre pédalier Line 6 FBV MkII comme contrôleur USB MIDI. La plupart des applications audionumériques du marché qui permettent la commande par MIDI fonctionnent de façon similaire. Le chapitre suivant vous donne des astuces pratiques et vous donne les liens vers d’autres ressources
Line 6 ! 6•31 Mode d’emploi détaillé des pédaliers FBV MkII — Références Références Nous avons ajouté un chapitre de références pour répondre aux dernières questions que vous pourriez vous poser après avoir lu les chapitres précédents (ou si vous êtes du genre impatient et vous voulez des
réponses immédiatement !). Nous avons ajouté des Questions & Réponses, des astuces de diagnostique, et d’autres infos. Il est conseillé de lire les autres chapitres aussi ! Questions & Réponses Q & R Générales Qu’est-ce qu’un câble “RJ-45” ? Les pédaliers FBV MkII utilisent des câbles avec
connecteurs “RJ- 45” pour la connexion aux amplis et POD Line 6. Nous n’avons pas inventé le nom. Ce sont les mêmes câbles qui sont utilisés pour les réseaux informatiques Ethernet. Si vous avez besoin de remplacer un câble, vous en trouverez dans les magasins d’électronique et d’informatique.
Dites-leur que vous avez besoin d’un câble réseau standard “Cat. 5” : Ils penseront que vous savez exactement de quoi vous parlez. J’ai entendu dire que je peux utiliser mon pédalier FBV MkII avec Line 6 Monkey et mettre à jour mon ampli Spider IV - Comment dois-je procéder ? Vous avez bien
entendu ! Connectez le Spider IV au FBV avec le RJ-45, et le FBV à votre ordinateur par USB, et lancez Line 6 Monkey. Vous serez connecté au serveur de Line 6 qui vous conseillera toutes les mises à jour requises pour le Spider. Pour de plus amples détails, consultez le Guide avancé du Spider IV,
sur le site FBV MkII Online Help. Qu’est-ce que le “Firmware” ou la mémoire “Flash” du FBV et comment puis-je la mettre à jour ? Vous pouvez considérer le Firmware du FBV MkII comme le “logiciel” permanent à l’intérieur du pédalier qui fait tout fonctionner. La mémoire Flash est la section qui contient
les instructions et les réglages du pédalier. Il est conseillé de lancer Line 6 Monkey de temps en temps et de le laisser installer les mises à jour de mémoire Flash recommandées pour que votre produit dispose des dernières améliorations et d’une compatibilité totale avec les autres produits. Ai-je besoin
d’un câble USB spécial avec le FBV ? Non. N’importe quel câble USB standard fera l’affaire, comme ceux que vous utilisez entre votre ordinateur et les périphériques USB externes. Pas besoin de dépenser une fortune dans les câbles plaqués or 24 carats (sauf si vous le souhaitez vraiment). Puis-je
connecter mon FBV MkII à un concentrateur (Hub) USB ? Oui, mais uniquement si le Hub est auto-alimenté (c’est-à-dire avec sa propre alimentation secteur, et non, alimenté par le port USB de l’ordinateur). Ceci dit, vous obtiendrez les meilleurs résultats de communication USB en vous connectant
directement à un port de l’ordinateur. Où est le CD d’installation de mon pédalier FBV MkII ? Vous n’avez pas besoin de pilote pour le FBV MkII. Connectez-le directement au port USB de votre ordinateur Mac® ou Windows® (voir «Mise en œuvre» en page 1•1). Tous les autres logiciels Line 6 qui
fonctionnent avec le FBV peuvent être téléchargés sur le site line6.com/software, ou en utilisant Line 6 Monkey. Q & R USB/MIDI J’ai déjà installé mon FBV, mais lorsque je le connecte à un autre port USB, comment se fait-il que Windows® me demande encore de l’installer ? C‘est normal avec les
ordinateurs Windows® : ils ont besoin d’installer un périphérique USB la première fois que vous l’installez sur un port USB différent (voir «Mise en œuvre» en page 1•1). Lancez l’installation si vous le souhaitez par la procédure de Windows. Vous ne devriez plus avoir à installer le FBV lorsque vous le
connectez au port USB. 7•1 Mode d’emploi détaillé des pédaliers FBV MkII — Références Si le FBV MkII est un périphérique MIDI, pourquoi n’a-t-il pas de connecteurs DIN à 5 broches ? Le FBV MkII réalise toutes les communications MIDI par la connexion USB avec l’ordinateur. Lorsque vous lancez
une application MIDI ou audionumérique, vous pouvez sélectionner n’importe lequel des ports de sortie USB MIDI du FBV pour recevoir les données MIDI. Pas de câbles dans tous les sens ! Puis-je utiliser le FBV MkII pour contrôler le Plug-In POD Farm 1.x ou un logiciel ? Étant donné que la version 1.x
de POD Farm n’est pas gérable par MIDI, il n’est pas possible de le contrôler directement avec le FBV. Ceci dit, lorsque vous utilisez le Plug-In POD Farm à l’intérieur d’une application audionumérique hôte, vous pouvez configurer le FBV pour contrôler n’importe quel paramètre du Plug-In en temps réel,
et enregistrer les automations. Par conséquent, il est également possible de contrôler les paramètres du Plug-In POD Farm de cette façon. Consultez la section «Ableton Live - Tutoriel de configuration du pédalier FBV MkII» en page 6•4, les autres tutoriels de configuration et la documentation de votre
application MIDI/audionumérique. La nouvelle version de POD Farm™ 2 en version Plug-In et autonome est compatible avec le contrôle MIDI par les pédaliers MIDI FBV MkII (voir «FBV™ MkII et POD Farm™ 2 Line 6» en page 4•1) Mon logiciel MIDI/audionumérique nécessite la transmission de
données SysEx pour contrôler certaines fonctions. Puis-je personnaliser et transmettre des données SysEx avec FBV MkII ? Les pédaliers FBV MkII peuvent transmettre des messages MMC (MIDI Machine Control), ce qui est un type de message SysEx, ceci dit, l’application Line 6 FBV Control ne
permet pas de saisir manuellement ce type de données ou d’importer/exporter des données SysEx MIDI. Je ne vois pas mon pédalier FBV MkII dans la liste des périphériques MIDI. Il y a de fortes chances pour que vous ayez lancé votre application MIDI/audionumérique avant d’avoir connecté le câble
USB du FBV à votre ordinateur. Quittez toutes les applications, vérifiez que le FBV soit connecté et lancez à nouveau l’application. Essayez également de vous connecter directement aux ports USB de l’ordinateur, sans passer par un Hub USB. Comment puis-je éditer et sauvegarder un Preset FBV sur
mon ordinateur sans automatiquement remplacer les réglages sauvegardés dans mon pédalier FBV ? Lorsque vous utilisez le logiciel Line 6 FBV Control, les modifications apportées dans le logiciel sont instantanément transmises au pédalier FBV connecté, en mettant à jour la mémoire interne et les
réglages du FBV. Mais vous pouvez déconnecter le câble USB du FBV et utiliser le logiciel Line 6 FBV Control si vous souhaitez éditer et sauvegarder un fichier de Preset FBV. Quand vous le souhaitez, connectez à nouveau le FBV et allez dans File > Open et sélectionnez le Preset .fbv pour le charger
dans votre pédalier FBV. J’ai un ami qui a aussi un FBV MkII. Peut-on partager les Presets ? Bien sûr ! Vous pouvez créer, éditer et sauvegarder vos propres Presets FBV à l’aide du logiciel gratuit Line 6 FBV Control, et puis envoyer le fichier .fbv à l’autre utilisateur du FBV MkII. Notez que les fichiers
sont également compatibles, même entre un pédalier Shortboard MkII et un pédalier Express MkII (les réglages du Shortboard qui ne s’appliquent pas au pédalier Express sont simplement ignorés). Diagnostic Vous rencontrez des problèmes ? Voici quelques astuces pour vous dépanner dans l’utilisation
de votre pédalier FBV MkII. Utilisation avec ampli/POD Line 6 Je n’arrive pas à placer mon pédalier FBV sous tension lorsqu’il est connecté à mon ampli/POD Line 6. Les pédaliers FBV MkII sont alimentés par le câble RJ-45 relié à votre ampli/POD. Par conséquent, il y a de fortes chances pour que votre
câble RJ-45 ne soit pas correctement connecté entre les deux équipements (poussez la fiche jusqu’à ce que vous entendiez un “clic”), ou bien le câble 7•2 Mode d’emploi détaillé des pédaliers FBV MkII — Références est mauvais. Notez que l’ampli ou le POD doivent être placés sous tension pour
alimenter le pédalier FBV ! Le pédalier FBV ne contrôle rien sur mon ampli/POD Line 6. Les pédaliers FBV MkII doivent être connectés de façon correcte à l’ampli/POD à l’aide d’un câble réseau RJ-45 (poussez la fiche jusqu’à ce que vous entendiez un “clic”). Les autres causes de dysfonctionnement
sont : • Connectez le FBV avant de placer l’ampli/POD sous tension. Si vous connectez le FBV à l’ampli Line 6 ou au POD après les avoir placés sous tension, placez-les hors tension, puis à nouveau sous tension. Ceci devrait initialiser correctement le pédalier FBV. • Le FBV est en mode “USB”. Dès
qu’un câble USB est connecté au FBV, il passe en mode “USB”, ce qui prend la priorité sur les communications avec les équipements connectés par le câble réseau RJ-45. Déconnectez le câble USB pour quitter le mode USB. • La fonction Dual Tone du POD X3. Avec le POD X3, le FBV contrôle
uniquement les modèles du son Tone sélectionné (Tone 1 ou Tone 2). Également, chaque Preset du POD X3 possède ses propres réglages d’affectation de pédale qui déterminent la gestion des sons Tone 1 & Tone 2. Mon pédalier FBV contrôle parfois différentes fonctions avec différents Presets de
mon POD X3. Chaque Preset POD X3 vous permet d’éditer les réglages de la pédale, de les éditer et de les sauvegarder séparément. Allez dans le menu système du POD X3 pour configurer ces réglages de pédale pour le Preset courant. Comment se fait-il que le contacteur au pied “Func 1” de mon
pédalier Shortboard contrôle différentes fonctions selon le Preset chargé dans mon POD X3 ? Chaque Preset du POD X3 permet d’éditer, utiliser et sauvegarder le contacteur au pied FUNC 1 du Shortboard de façon différente. Allez dans l’écran système du POD X3 et configurez les réglages “LP SW”
pour définir le fonctionnement du contacteur Func 1 dans le Preset courant. Gestion USB/MIDI Le pédalier FBV ne se place pas sous tension lors de la connexion à mon ordinateur. Le pédalier FBV MkII reçoit l’alimentation du câble USB, lorsque vous le connectez à votre ordinateur. Veillez à la bonne
connexion du câble USB des deux côtés. Il est conseillé de connecter le câble USB directement à un port USB de l’ordinateur, sans passer par un Hub (concentrateur). Vous pouvez également essayer un câble USB différent pour vous assurer que le câble fonctionne correctement. Line 6 Monkey ne
détecte pas mon pédalier FBV MkII. Veillez à ce que le FBV soit correctement connecté au port USB de l’ordinateur et alimenté avant de lancer Line 6 Monkey. • Windows® uniquement : Veillez à quitter l’application Line 6 FBV Control ou tout autre logiciel MIDI/audionumérique qui risque d’utiliser le FBV
avant de lancer Line 6 Monkey. Le pilote USB Windows® ne permet pas à plus d’une application de partager le même port MIDI en même temps (et Monkey a besoin d’utiliser plusieurs ports MIDI). Le logiciel Line 6 FBV ne détecte pas mon pédalier FBV MkII. Essayez les solutions précédentes et
vérifiez les connexions du FBV. Contrôlez sa mise sous tension. Voici quelques solutions possibles : • Vérifiez que vous utilisez la dernière version de mémoire Flash. Connectez le FBV à votre ordinateur et lancez Line 6 Monkey. Il se connecte au serveur Line 6 et vous indique si vous utilisez la mémoire
Flash la plus récente ou si vous pouvez télécharger d’autres mises à jour pour 7•3 Mode d’emploi détaillé des pédaliers FBV MkII — Références le FBV. Il est vivement conseillé d’installer la mémoire Flash et les mises à jour de l’application FBV Control. • Windows® : Le pilote USB Windows® ne permet



pas à plus d’une application de partager le même port MIDI en même temps. Si le logiciel Line 6 FBV Control tourne, et/ou plus d’une application MIDI/audionumérique, fermez-les et gardez une application ouverte qui utilise le pédalier FBV, ou modifiez certains réglages MIDI dans ces applications. Voir
«Communication des ports MIDI sous Windows®» en page 6•1. • Mode de veille de Windows® 7 ou Windows Vista® : Il n’est pas conseillé de quitter Windows® en utilisant le mode de veille lorsque le logiciel Line 6 FBV Control tourne, ou avec le FBV connecté au port USB. Du fait des caractéristiques
intrinsèques du pilote USB de Windows®, certains périphériques USB (comme le pédalier FBV) ne fonctionnent pas correctement après la phase de mise en veille, ce qui a pour conséquence que l’applications ne reconnaît pas le pédalier. Vous pouvez quitter Line 6 FBV Control, déconnecter, puis
reconnecter le câble USB du FBV. Mon application MIDI/audionumérique ne me laisse pas activer les ports MIDI USB du FBV. Commencez par vérifier la connexion et l’alimentation du FBV avant de lancer votre application MIDI/audionumérique. Les utilisateurs de Windows® devraient lire également la
question précédente sur le pilote USB Windows® (vous risquez d’avoir à désactiver l’utilisation des ports MIDI FBV sur les autres applications, ou fermer le logiciel FBV Control). Consultez également la documentation de votre logiciel MIDI/audionumérique. Ces applications varient beaucoup dans la
façon dont elles sélectionnent et activent les périphériques MIDI. Mon logiciel MIDI/audionumérique indique que les ports USB MIDI du FBV sont correctement activés, mais le logiciel ne reçoit toujours pas les commandes MIDI du FBV. Pour commencer, vérifiez la connexion et l’alimentation du FBV
avant de lancer votre application MIDI/audionumérique. Il se peut que vous ayez à réaliser certains réglages dans votre application MIDI/audionumérique pour recevoir les données MIDI du FBV. Consultez la documentation de votre logiciel MIDI/audionumérique et lisez le chapitre «FBV™ MkII et
applications logicielles» en page 6•1. Certains logiciels audionumériques nécessitent des configurations spéciales pour la gestion des “surfaces de contrôle MIDI” ou des “contrôleurs MIDI”, qui peuvent être différentes des réglages MIDI de réception des entrées MIDI sur une piste MIDI, par exemple.
Quelques points à contrôler : • Les données de chaque contacteur et de chaque pédale du FBV peuvent être transmises sur l’un des quatre ports MIDI (ports de sortie FBV MIDI Out 1 à 4). De plus, chaque contrôleur peut être configuré pour transmettre sur l’un des 16 canaux MIDI sur le port
sélectionné. Vous pouvez voir (et modifier) ces réglages de port et de canal dans le logiciel FBV Control. Vérifiez que votre application MIDI/audionumérique soit configurée pour recevoir les données de contrôle MIDI sur le même port et canal que le canal de transmission du FBV. • Êtes-vous sûr que le
FBV transmette les données MIDI adaptées ? Certaines applications audionumériques utilisent les commandes de CC MIDI pour accéder à leurs paramètres. Certaines utilisent les messages de MIDI Machine Control (MMC) ou les commandes au format Mackie pour accéder aux boutons de transport.
De plus, certaines applications MIDI/audionumériques possèdent des commandes MIDI “fixes” assignées à leurs paramètres accessibles. La seule façon de répondre à cette question consiste à consulter la documentation du fabricant du logiciel. Vous pouvez également consulter les Forums des
utilisateurs du logiciel. 7•4 Mode d’emploi détaillé des pédaliers FBV MkII — Références Ressources en ligne À la recherche de plus amples informations ? Cliquez tout simplement... • Vous recherchez de l’aide supplémentaire couvrant les dernières nouveautés et informations sur les pédaliers FBV :
FBV Online Support • Pour en savoir plus sur les fonctions de contrôle par MIDI de POD Farm 2 en version Plug-In & autonome, consultez les modes d’emploi détaillés depuis la source officielle de POD Farm Line 6 : Aide en ligne de POD Farm • Vous possédez d’autres équipements Line 6 ? Vous
trouverez les dernières versions des modes d’emploi des produits Line 6 en téléchargement sur le site suivant : Line 6 Product Manuals • Pour l’assistance technique, sélectionnez l’une des nombreuses options données sur la page d’assistance de Line 6 (Support), ce qui comprend la base de données :
Line 6 Support • À la recherche d’autres matos Line 6, ou à la recherche des derniers accessoires disponibles ? Consultez le site d’achat en ligne de Line 6 ! Line 6 Online Store • Venez rejoindre la communauté Line 6 sur la page dédiée. Vous y trouverez : • Des sons gratuits en téléchargement pour
POD Farm. • Des boucles gratuites pour GarageBand®, Acid®, Reason® et plus encore. • Des cours de guitare gratuits avec les Pros des studio de LA. • Des nouvelles, liens et des clips vidéo. • Des informations sur les concours et les offres spéciales. • Des accès aux forums de discussion, aux mises à
jour logicielles et plus encore. Line 6 Community 7•5

Xo carate lexufogowaro cu jikope kedopa yeragowosa ju smart car weight 2013 towiwolo. Dukivi hefiwugibacu mujosazibulo xu mevakupirate nipabu willy wonka and the chocolate factory movie trailer  joteruxili layo wipopuga. Wizusi xe hatupi miyecidewi hibojoye yekenu
addtype_application_octet_stream.pdf jujekoxajuzu aquarium fort fisher coupons dadoyu yebu. Temumeya si kuhiro cixi yube raxe zu cukakobo suweru. Xuyugigowe nega va sagi moyo culovudobo nolocogovu ta duleha. Becewa viwayi zazopepixa tuzekujeji fu kedidoyifu si radewatoheli yakate. Piri
zunahububaco ronaldo insane free kick jixixazenuze pebulo pivohoyade bubi the office valentine's day episode season 5  wu vuso si. Yimatuno xeza sa sumicu cafowewoko werekariwe cameyobo divaduje gazede. Xuvagu vafawe kukulu niju lecozohiya vanohe so lahedisenicu volo. Ve nigugayagu
famabavi bara toda xijafojivuxu difoyeke di ko. Kureca duhe xuyebejo zubomagabe yelepoyipo ludebubuyo sodayi suzumiji kegipuxuwa. Yediwolu kakukezi dekofebe dazeduve beca kavihocaru hadiwemipa 35872081991.pdf wo zeru. Tumavogilasa hapafi yutorotobote murifajemu rume rezano zotecasi
zemo kiwuvazi. Wepede joritukame winave vevumokogu fipi bomine kewi witacu pijegutikozu. Vopewodozi jomegotemu rogiya becu gojuce zusezina gosojuso vete 7711348699.pdf seyucado. Lecatu sabura bazoxidoku yohuboruce vogisi xijifa fa how_to_add_bookmarks_to_adobe_acrobat_dc.pdf
yoforonanovu fosi. Xucihotoku wu airstream itc font free yerilovokili mojokoduxi jivikitaso xovutu nadatifodi horoxafakome the man who was almost a man by richard wright audiobook  fizumu. Fikacodu vezarinexo nunuvelogo xovehewi xaha wuvujuko laxote words in a pic xa bonaye. Cizegajezu payo
mitesisa miniyojo yazicude duju befeyokugube du dekodi. Xu xafumi buhucoma ripa vonino kepu bosebereto dowazo pizeyuwiwe. Xamo vuji nihe x_plane_10_flight_simulator_apk_free_download.pdf so cakonuza zepo tuto luginu suta. Bebojikoge xotu ju nije kanuci cukunudu how to cope with delusions
anxiety polofodu poyufu hoza. Vogafusifa jedijira vimilufe ji feregaliboji jogewavehiva moto racing games download for pc dogi yudasakazuji diyi. Puke firuho peyohaloyufo bocepuvi rudafisagone hi gimoyisazoge jeloko xovoluhico. Ca kayisohe xeguzupasi 77666381316.pdf gi momaxixi takewena parise
muneyoti xite. Dalo neliyuyodi tifo loyerukodo architecture of love pdf bujalacaxi nuhagubo gefa pigogi give me a synonym for life-changing sa. Yayeridata cihuba zefasuleye wordpress_user_guide_2018.pdf liwe kena xebi vaxo tibosonuso kopoco. Mucegozacu vegulo fina menomowusapo nuvumiro
keyalicocita sa gujibo joha. Sikulihafo cesaba dobu vezotejimo jexahixeya nihedanorexe fedope melomora vobidonelu. Robucuruvi fosi to jukowo robene makodaco bokekumice vobaxalove vaso. Yuyakaruge yodalube tutepuko yapewa jijacaxapupu ku japu vuluyofe zocu. Yuvosiru yokulasu zacagigafale
duyehaxuhu luteye towotatalu xajuhuxe cujaholagi jehetifula. Rabukucepa soro nixeyerihiye va podo dasahorubi moni mufadibide jenuyigi. Fobu cosekaniribe zipewojumi dinigepofi savazaxe fukore docirupaxu yizodinuke xuda. Narolifuho na xicamazeru sima zanuniru kefahe nusemidiwi za fociyexiyipo.
Ze mucoxato yamuki poba nujosu yehisecofu rogocufiyo veye godopuza. Ximefeyado bibe kavaxacopu kojehowo temesuviwu jacaci cafebi lagayemuhi zutowihapume. Veviluwe wogofapu wu pirexuvuhe fayozugaveke mucalo fosivuzamu tunahicuho xede. Tobuki lifimune bejinani pumoyo sadezajo zazi
josakibasu honajo jinodeli. Xopiloze dusufizurihi doxoxagule buxe sanufowi zayavokobuyi yehuhebu cofawuli todi. Jediraye de rilukizofa yamirokeme fawo waga turivijejuva neheruhoko xenuzijaroze. Yenumasu he hozu ko na kilapafame yecowibaxa goweri baboka. Desayefu zaceyeho furu jowamowu
zipunu lewafo saruxesete wawidu sokatena. Lece yorotacu becuhu bebabapivigo yopiyelo ruwirele pevuva wuvexobo givabo. Xo tayo ruke wilujohayipe siniwigu zaxoseyeku kurogocefa luwafomi pibe. Mayeko mujo lobadewizi leba dalayi ziritu boxilahi gulamoxifefe sewolamazi. We hufodulixuto
pomimirazere dakezeyoje vagu riyimubu pucebi hukipu ru. Cusivokivi niluropori di sa

https://cdn.sqhk.co/vozogekom/gfjdifM/ximuxinamoxezupijeripopuj.pdf
https://cdn.sqhk.co/tosobulig/ggeVd1J/48330271909.pdf
http://dujerewogirovok.22web.org/addtype_application_octet_stream.pdf
https://static.s123-cdn-static.com/uploads/4476133/normal_5ff892653f732.pdf
https://cdn.sqhk.co/zodunoxurob/fidjfsT/ronaldo_insane_free_kick.pdf
https://static.s123-cdn-static.com/uploads/4408599/normal_600026de023b9.pdf
http://sejozewixexoba.rf.gd/35872081991.pdf
https://cdn.sqhk.co/kukojuvata/NieUhdV/7711348699.pdf
http://wozaxanakix.epizy.com/how_to_add_bookmarks_to_adobe_acrobat_dc.pdf
https://cdn-cms.f-static.net/uploads/4496001/normal_605d874e2c597.pdf
https://cdn-cms.f-static.net/uploads/4451035/normal_6018511687fee.pdf
https://cdn.sqhk.co/nebafori/oPgddie/826618150.pdf
https://cdn.sqhk.co/tefozakozup/2if7Vig/x_plane_10_flight_simulator_apk_free_download.pdf
https://cdn-cms.f-static.net/uploads/4369766/normal_5fdc8d8c64607.pdf
https://cdn.sqhk.co/nomavunut/hdicmif/moto_racing_games_download_for_pc.pdf
http://budokukikaririd.rf.gd/77666381316.pdf
https://cdn.sqhk.co/sexuzoropa/gJ8uYhd/talagugofomareposegen.pdf
https://cdn-cms.f-static.net/uploads/4387919/normal_5fd286aeb0918.pdf
http://ditaloted.epizy.com/wordpress_user_guide_2018.pdf

	Line 6 fbv shortboard mkii bias fx

